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Introduction

Section 1: Introduction

1.1 What is DCMlink Software?

One of the biggest challenges faced when controlling electric actuators is control and visibility. 
When plant personnel operate an entire facility, the ability to operate valves and know 
equipment status is critical. Generally, electric actuators provide the information needed, but 
when controlling numerous devices, in different open protocols and brands, using a centralized 
software to control and monitor the actuators is just not possible as different brands and 
protocols will not be recognized by a single software. 

DCMlink software allows customers to diagnose, configure, and monitor all EIMTM  and BettisTM 
electric actuators from a central location independent of protocol, actuator, or host system.

This software presents information in a consistent, easy-to-interpret, human-centered design 
that provides the capability to diagnose, configure, calibrate, and monitor all electric actuators 
from a central location, independent of the protocol, actuator, or host system.

DCMlink Benefits:

1. Integrates with Emerson’s PlantWeb™ solution.

2. Diagnose, configure, calibrate, and monitor all electric actuators from a central location, 
independent of the protocol, actuator, or host system. 

3. Improve maintenance efficiency, and reduce maintenance costs.

4. Unified user interface for all electric actuators including support for TEC2, EHO, TEC2000, 
M2CP, MPA, HQ Series, and XTE3000.

5. Advanced diagnostics include torque profile curves, valve control and status monitoring.

6. Communicate using Modbus, XTE RS-232, TCP-IP, Bluetooth, and HART protocols.

7. Easy configuration and calibration methods.

8. Integrated management of asset data, profiles, alarm, and event logs.

9. PlantWeb compatible alarms in NE-107 format, alarm log, and event log features.

10. Real time actuator monitoring and control.

11. Easy navigation with simplified tree view and logo view. 

12. Easy Firmware Download support for TEC2 & XTE3000.
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1.2 Purpose of this Guide

Using DCMlink, an instrument engineer, maintenance technician, or operations supervisor can 
determine the status of an EIM and Bettis smart electric actuator to detect problems before they 
impact the process. It provides an easy-to-use environment for diagnosing, configuring, and 
monitoring of the operating characteristics of any EIM and Bettis smart electric actuators.

DCMlink User's Guide:

1. Provides a comprehensive guide for installing, initializing and utilizing DCMlink.

2. Provides guidance on how to digitally monitor and control valve actuators and valves in 
a specified network.

NOTE:

User's Guide will be updated when new versions of the software are released.  
To ensure you have the latest version and information, go to the Emerson DCMlink download page.

In case there are any questions or inquiries regarding this User's Guide and supporting  
information, please do not hesitate to contact your Local Business Partner (LBP) or nearest 
Emerson office.

1.3 DCMlink Compatible Actuators

Figure 1 Emerson Electric Actuators

 

https://www.emerson.com/en-us/catalog/eim-dcmlink-software


User's Guide 
DCM-402-0818 Rev. 2.3 February 2020

3

Section 2: Initial Setup

Initial Setup

Section 2: Initial Setup

2.1 Before You Begin

The DCMlink software installation process includes several steps, some of them dependent on 
the type of personal computer system that will run DCMlink software and its configuration.  
In order to successfully install and run DCMlink software, it is important that the user follows all 
of the appropriate steps covered in this installation guide.

Prior to beginning installation, please:

• Verify if personal computer system meets the hardware and software 
requirements specified in this section.

• Gather the necessary installation tools and documentation.

2.2 Installation Tools and Device Documentation

Before begining the installation procedure, make sure the following items are available:

•  DCMlink software installation media (software download link, CD, or USB media).

•  Any hand tools (i.e. screwdriver) needed for installing communications hardware.

• Communications hardware such as the RS485 modem, and any necessary  
wires, cables, or other equipment specified in the device documentation for the  
RS485 instruments.

•  Personal computer with a serial or USB port for connecting to a RS485 modem, HART 
modem, DeltaV, RS-232 Cable, Multiplexer, wireless gateway.

2.3 System Requirements

DCMlink Software 2.3, has been tested on computers manufactured by Dell, Inc. However, 
DCMlink software runs on any personal computer or notebook computer equipped with the 
following software and hardware features:

NOTE:  

Actual requirements and product functionality may vary based on system configuration and 
operating system. DCMlink Software 2.3, has not been tested on a personal computer using  
the Windows 95 operating system and is not supported on Windows 2003, Windows 98, 
Windows Me, Windows NT, Windows 2007, or Windows XP operating systems.
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2.4 Supported Operating Systems

DCMlink SOLO

• Windows 10 (64 bit)

NOTE:  

DCMlink Software is not supported on Windows XP (32, 64 bit), Windows 2007,  
Windows 7 (32/64 bit), and  Windows 2012 server (64 bit).

2.5 Software Requirements

Internet Explorer version 11.0 or later is recommended.

Microsoft Excel for exporting of Event log information is needed.

2.6 Hardware Requirements

• Computer and processor:

 — 1 Gigahertz (GHz) or faster processor needed

• Memory:

 — 2 Gigabyte (GB) RAM (32-bit) or 4 Gigabyte (GB) RAM (64-bit)

• Hard disk:

 — 256 Gigabyte (GB) available storage space

• Drive:

 — CD-ROM Drive

• Display:

 — 1024 X 768 resolution

 — 256 colors

• COM ports:

 — Serial or USB port for connecting to a RS485 modem

• Bluetooth:

 — Microsoft Bluetooth stack or WIDCOMM® stack compatible built-in/external 
Bluetooth adapter

• RS485 converter:

 — Recommend using USOPTL4, optically isolated product from B&B Electronics
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2.7 Features

• Status Monitor 

• Detailed Setup

• Valve Control

• Torque Profile

• Pressure Profile

• Analog Calibration

• Port Calibration

• Event Log

• Firmware Download

• Custom Characterization

• Modbus Master

• Modbus Slave

• Modbus TCP-IP

• XTE RS-232

• Bluetooth

• HART

2.8 Compatible Devices

2.8.1 Firmware Compatibility:

NOTE:  

DCMlink is tested with the below actuator firmware combinations.

Table 1. Actuator Firmware Compatibility

Actuator Status/Firmware Date

TEC2000

CCM: 132 dated 2015_MAY_13 or later 
LDM: 119 dated 2014_AUG_07 or later  
ACM: 140 dated 2016_MAY_27 or later 
APD: 114 dated 2013_DEC_05 or later 

TEC2
CCM: 110 dated 2019_MAR_18 or later 
LDM: 110 dated 2019_MAR_11 or later 
Language File: dated 2015_11_20 

M2CP M2CP_320B_361_2019_02_04.hex or later 

MPA MPA_624_2016_05_09.hex or later 

HQ-DCM33 HQ_DCM33_503_2015_05_27.hex or later 

HQ-DCM32 HQ_DCM32_403_2014_03_15.hex or later 

Smart EHO Modulation Smart_EHO_Modulation_1.0.15_12-Feb-2019 or later 

Smart EHO Motor Smart EHO On-OFF_2.0.17_8-Mar-2019 or later 

Smart EHO Double Acting Smart_EHO_DoubleActing_3.0.1_12-March-19

XTE3000
Software (H8) rev. 9.02
Software (Pic) rev. 8.0 
Logic (Base) board: DE9425
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Table 2. Compatibility Number

Actuator Supported DCMlink Version

1

1.0
1.1
1.2
2.1 
2.2
2.3

NOTE:  

Please ensure the actuator is configured with the correct compatibility number with the  
installed version of DCMlink. If it is less than the matching version (as per table above),  
please upgrade the actuator firmware. If it is greater than the matching version, please upgrade 
DCMlink software.

2.8.2 CAM Cards 
The CAM209 is for TEC2000, and TEC2. While the CAM09 is for M2CP, MPA, HQ 
DCM33 and EHO (See chapter for Modbus Initial Configuration). HQ DCM32 does not 
provide the option to connect an additional CAM card.

Table 3. EIM, Bettis CAM Card Actuator Compatibility

Protocol Name
M2CP Family  
(M2CP, HQ, MPA, and EHO)

TEC Family  
(TEC2 and TEC2000)

Modbus CAM05 CAM205

Modbus TCP/IP CAM09 CAM209

HART CAM16 CAM216

FOUNDATION fieldbus CAM28 CAM228

Table 4. XTE3000 Card Actuator Compatibility

Protocol Name XTE3000

Modbus Modbus BUS Card 494MOD1200

HART HART BUS Card 494HRT2000v4
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2.9 Known Limitations

2.9.1 Actuators: DCMlink does not support M2CP 320A or non-protocol versions of the 
M2CP actuator (it supports M2CP 320B).

2.9.2 The installation of DCMlink requires administrator rights.

2.9.3 Multilingual installation is not supported in DCMlink.

2.9.4 The Operating System UAC Level > 1 may result in the display of a message seeking 
privilege to run DCMlink.

2.9.5 Standard operating system themes are recommended when using DCMlink as this 
software does not support high contrast themes.

2.9.6 DCMlink is unable to detect TEC2 at 115200 Baud Rate using the Microflex 485 
converter.

2.9.7 EHO: Model Operating Pressure (MOP)/Maximum Self Calibration parameters  
require Setup Mode. Please use Actuator Mode to enter into Setup Mode to modify 
these parameters.  

2.9.8 EHO: Actuator Fully Open Time and Close Time parameters do not show any value  
on DCMlink.

2.9.9 DCMlink cannot configure "Lost Analog Delay Time" parameter in case of  
TEC2000 actuator.

2.9.10 DCMlink cannot configure "Speed Control Bandwidth" parameter in case of  TEC2000/ 
TEC2 actuator.

2.9.11 DCMlink Release 2.3 supports only English(US) language, check settings from Control 
Panel->Region and Language -> Format. When format changed from English (US) to 
other country format user may face issues in DCMlink. 

2.9.12 Scheduler status and execution would misbehave if user starts scheduler execution 
when any other screens are opened in DCMlink. 
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2.9.13 Adding same live tag name to second task is not implemented (E.g.: PST is schedule  
for device 1 tag, and again re-schedule PST in same live tag is not implemented.  
User has to delete the completed task and need to “Add task.”)

2.9.14 At the same time we can not add the task for multiple device.

2.9.15 Two task at same time is not implemented for same live device tag (E.g.: Extract device 
info, PST tasks cannot be run at same time. It is implemented in sequence.)

2.9.16 HART modem on DCMlink SOLO is not supported in this R#2.3.

2.9.17 Setup mode need to be manually exit at configuration screen  
(Actuator mode > Exit setup mode). 

2.9.18 Firmware download option is only applicable for TEC2 device in Modbus protocol. 

2.9.19 Not enough quota is available to process this command message box appears in 
DCMlink. Workaround: Close the DCMlink application and launch it again.

2.9.20 DCMlink shows unexpected error "Gregorian date" on status monitor screen. 
Workaround: Close the DCMlink application and launch it again.

2.9.21 DCMlink gives - Device not found during XTE3000 Firmware read operation. 
Workaround: Close the Firmware dialog and read the FW again.
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Section 3: Installing DCMlink

3.1 Installation Overview

DCMlink Software should be installed on a computer that meets the system requirements.  
The following steps detail how to uninstall and reinstall. Reinstall if the software is to be removed, 
updated, or repaired only.  

3.2 New Installation

 CAUTION
- If the user has a previous version already installed, please uninstall it first from the Control 
Panel >Add Remove Programs. Next, please delete the DCMlink shortcut from the Desktop. 
- If the user has latest version of DCMlink already installed and wants to install Prior build of 
DCMlink on top of it then recommendation is to uninstall the latest version of DCMlink from 
Add/Remove programs then only install the prior builds of DCMlink.

3.2.1 Locate and then open the DCMlink.exe located in the installation folder found in the  
DCMlink installer (sent to customer via web link, CD or USB media).

NOTE:  

Installation of DCMlink requires administrator privileges.

Figure 2 DCMlink Installer

Double Click on DMClink.exe
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3.2.2 Click Next button.

Figure 3 DCMlink Installation Initialization

Click on “Next” Button

3.2.3 There are 2 options for installation. Click on one option and then click Next.

• DCMlink SOLO 

• DCMlink SNAP-ON

NOTE:  

Both SOLO and SNAP-ON can be installed in one installation by selecting both options.



User's Guide 
DCM-402-0818 Rev. 2.3 February 2020

11

Section 3:  Installing DCMlink

Installing DCMlink

3.2.4 DCMlink SOLO

NOTE:  

Install DCMlink software for stand-alone operation.

Figure 4 DCMlink SOLO Option 
 

                     

Click on “Install” Button

3.2.5 DCMlink SNAP-ON

NOTE:  

Install DCMlink software enabled for operation as a SNAP-ON to AMS Device Manager.  
AMS Device Manager must be licensed for the DCMlink SNAP-ON.

Figure 5  DCMlink SNAP-ON Option  

Click on “Next” Button



February 2020
User's Guide 

DCM-402-0818 Rev. 2.3

12

Section 3: Installing DCMlink

Installing DCMlink

3.2.6 Read Terms and Conditions and select accept and click Next.

Figure 6 Terms of Use  

 

Read Terms &Condition and select the options 
I agree...

Click Next

3.2.7 Next, click Install.

Figure 7 Install DCMlink 

 

Click on “Install” Button
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3.2.8 Installation will begin.

Figure 8 Installation Progress Bar 

 

3.2.9 Click Finish to complete installation.

Figure 9 Completing the Installation

 

Click on “Finish” Button to complete 
the installation
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3.2.10 Start DCMlink application from desktop shortcut or from the list of All Programs.

Figure 10 DCMlink Start Menu Shortcut

Start DCMlink from dekstop shortcut or 
from list of All Programs

3.3 Reinstall and Repair

DCMlink reinstallation is an option available to repair a DCMlink installation without 
uninstalling it. Follow below to execute reinstallation:

3.3.1 Run DCMlink.exe located in the installation folder.

Figure 11 Initializing Reinstallation

Double Click on DMClink.exe
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3.3.2 After initializing the InstallShield Wizard, click Next. 

Figure 12 Ready to Reinstall

Click on “Next” Button

3.3.3 Click Install to begin reinstallation.

Figure 13 Begin Reinstallation 

Click on “Install” Button
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3.3.4 Reinstallation after step 3.3.4.

Figure 14 Reinstallation Progress Bar  

3.3.5 Once reinstallation completed, click Finish.

Figure 15 Reinstallation

Click on “Finish” Button to complete 
the installation
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3.4 Uninstall

3.4.1 There are two ways to uninstall the DCMlink software. The first method is performed  
by launching the DCMlink installer through the steps below:

3.4.1.1  Run DCMlink.exe located in installation folder.

Figure 16 Uninstall Using DCMlink Installer

 

Double Click on DMClink.exe

3.4.1.2 After initializing the InstallShield Wizard, click Next. 

Figure 17 Uninstall Window
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3.4.1.3 Select the Remove and click Next. 

Figure 18 Removing DCMlink

3.4.1.4 Uninstall begins.

Figure 19 Start Uninstallation
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3.4.2 The second method to uninstall of DCMlink is through the Control Panel in Windows.  
It can also be done by running the DCMlink installer. To uninstall via Control Panel, 
access Programs and Features, select DCMlink and click uninstall.  
Follow steps below:
3.4.2.1 Click Windows Start.

3.4.2.2 Click Control Panel.

3.4.2.3 Click Programs and Features.

3.4.2.4 Select DCMlink (published by Emerson). 

Figure 20 Uninstall from Windows Control Panel

 

3.4.3 Click Uninstall.

3.4.4 Next click Yes.

NOTE:  

If the Windows Administrator window pops up, click Yes to proceed with the removal of DCMlink.

3.4.5 After windows completes the uninstallation, any shortcuts to DCMlink will 
automatically be deleted. 
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Section 4: License Activation Wizard

4.1 License Features

Table 5. DCMlink License Features

Feature

Product Name

SOLO SNAP ON

SOLO Standard Unlimited
SOLO Advanced

(Under Development)
SNAP-ON Unlimited

Modbus Master P P Not Applicable

Modbus Slave P P Not Applicable

Modbus TCP-IP P P Not Applicable

Bluetooth P P Not Applicable

HART Modem Not Supporting P P

HART 
Multiplexer

P P P

Standard 
Diagnostics
(Torque Profile, 
Step Response)

P P P

Standard 
Diagnostics
(Partial  
Stoke Test)

P P P

Status Monitor P P P

Configuration P P P

Calibration P P P

Database 
With # of Tags

Unlimited Unlimited Unlimited
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4.2 Obtaining Your License

4.2.1 Double click DCMlink icon. The user will be prompted to run the License Wizard and 
click Yes.

Figure 21 Running License Wizard

 

4.2.2 Next click New License.

Figure 22 Request New License
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4.2.3 Enter the contact details. All fields are required. If the user does not have a fax number, 
please enter telephone number. This information will be used to request a license key.

 

Figure 23 Input License Information 

4.2.4 Select delivery method, and click Next.

Figure 24 Review License Information
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4.2.5 Provide the serial number and REP order number (e.g. DEMO).

Figure 25 Input Serial Number / REP Order Number

4.2.6 After the registration form is completed, the information can be saved and/or printed. 
Click Save to generate a license key request  file. Once complete, click Next. 

Figure 26 Input Received License Key
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4.2.7 The license request has now been sent to the DCMlink Registration Center. Click Finish.

Figure 27 Finishing the License Key Request

 

4.2.8 To obtain license, send license registration file to the email address mentioned in the 
above screen. User can also send a scanned copy of the printed registration form.  
Or call the number shown above to obtain the license key (please have the registration 
code/file ready).

4.3 Activating License Key File

4.3.1 After the user receives the license key file, please re-run the License Wizard by  
double-clicking on DCMlink icon and, click Enter License Key.

Figure 28 Entering the License Key File
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4.3.2 Click Import from File and select the license key file with the .lic extension.  
This is the license key file the user received via the DCMlink registration.  
Once loaded, click Next.

Figure 29 Import Existing License Key File

4.3.3 Once the license key has been imported, the installed DCMlink features will be shown 
on this window. Click Next.

Figure 30 Available Features Review 



February 2020
User's Guide 

DCM-402-0818 Rev. 2.3

26

Section 4: License Activation Wizard

License Activation Wizard

4.3.4 The following user information window will appear. If needed, the user may update the 
details. Click Next. 

Figure 31 Registration Information

4.3.5 DCMlink is now successfully licensed. Click Finish. 

Figure 32 Complete License 
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4.4 Activating Temporary License

DCMlink allows the use of a time-limited or temporary license that permits the use of certain 
software features for the duration of the license. Consult the following steps to activate this 
temporary license.

NOTE:  

By default, DCMlink Standard provides unlimited and SNAP-ON for 90 days trial. After the  
90 days trial period, the user needs to request a permanent license for SNAP ON.

4.4.1 Locate the license directory in the provided window and click Next.

Figure 33 Browse for License File
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4.4.2 Loading the temporary license provides the message below. Click Next.

Figure 34 Temporary License Loaded

4.4.3 Click Finish after the process is completed.

Figure 35 Temporary License is Complete  
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4.4.4 Activated software features are shown in the window below:

Figure 36 Software Features Listing
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Section 5: Get Started with DCMlink

5.1 How to Launch DCMlink

After successfully installing DCMlink, the program may be started by following the steps below:

5.1.1 Click (Windows) Start.

5.1.2 Click All Programs.

5.1.3 Click Emerson Process Management. 

5.1.4 Click DCMlink folder.

5.1.5 Click DCMlink icon.

NOTE:

Alternatively, DCMlink can be started by just double-clicking the desktop icon during  
the installation. 

Figure 37 DCMlink Icon

     

Figure 38 Starting DCMlink  
Start DCMlink from dekstop shortcut or 

from list of All Programs
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5.2 Home Screen

Once DCMlink is launched, the screen shown below is displayed. In this example, the tool bar 
items have been labelled.

Figure 39 DCMlink Starting Window (User Interface Legend)

 

Device Tag
Dataset Report

Print

Check Network
Actuator Mode
Detailed Setup

Scheduler
Batch Runner
Torque Profile
Status Monitor

Menu Bar
Tool Bar

Navigation (View)
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5.3 Software Information

Figure 40 DCMlink Start Screen

• Application Name: Lists the software name and version.

• Manufacturer: Shows the company that developed and published the DCMlink.

• Serial Ports Installed: Lists the number of detected serial ports.

• Serial Ports Configured: Lists the number of ports added in DCMlink.

• Modbus Master: Lists the number of ports added in Modbus Master.

• RDM Slave: Lists the number of devices configured for RDM Slave.

• Modbus TCP: List the number of detected Modbus TCP.

• Bluetooth: Lists the number of Bluetooth devices.

• HART Modems: Lists the number of detected HART modems.

• HART Multiplexers: Lists the number of detected HART multiplexers.

• Total Modbus Devices: Lists the number of detected Modbus multiplexers.

• Total XTE RS-232 Devices: List the total number of devices connected over XTE RS-232.

• Total RDM Slaves: Lists the number of total RDM slaves.

• Total Bluetooth Devices: Lists the total number of detected Bluetooth devices.

• Total HART Devices: Lists the total number of detected HART devices.

• Total Fieldbus Devices: Lists the total number of FOUNDATION™ fieldbus devices.
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5.4 Network Interface Connection

5.4.1 The network interface screen shows the selected protocol's starting display.  

Figure 41 Modbus Network Start Screen 

5.4.2 For serial port Information, select the configured COM Port in the navigation bar.  
This shows information related to the host computer and connected devices.

Figure 42 Serial Port Information

• Machine Name: Lists the name of the computer running DCMlink.

• Baud Rate: Shows the baud rate configured during the creation of the port. 

• Parity: Shows the parity (if any).

• Stop Bits: Lists the stop bits configured during the creation of the port. 

• Timeout Delay: Shows the delay set in communication before a timeout is recorded.

• Protocol: Shows the chosen protocol for the created port.

• Devices Attached: Lists the number of devices detected in the port.
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5.5 Connected Device Information

5.5.1 Device information display shows all the information from a detected actuator tag.

Figure 43 Device Information

• Tag Name: Lists the tag name of the selected actuator tag.

• Actuator Style: Shows the type of actuator detected.

• Actuator Serial Number: Displays the actuator serial number.

• Device Type: Indicates the model of the selected actuator.

• Device Address: Lists the port address of the selected actuator.

• Firmware Revision: Shows the firmware revision of the selected actuator.
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Section 6: Configuring Preferences

6.1 Configuring Communications in Modbus 

There are 3 different sections for Modbus Protocol:

• Modbus Master

• RDM Slave

• TCP

6.1.1 Configuring Communications in Modbus Master

6.1.1.1 From the menu bar, click DCMlink Setup. 

6.1.1.2 Click Preferences.

Figure 44 Preferences in Menu Bar

 

Step 1

Step 2

6.1.1.3 On Preferences window, click Communication tab.

6.1.1.4 Click preferred protocol and click Add.

6.1.1.5 Click Mode. 

 — There are three different sections for Modbus Master/RDM Slave/TCP.

NOTE:

Modbus TCP is based on the DCMlink license that user has.
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Figure 45 Steps 3, 4, and 5

 

Step 5
Step 3

Step 4

6.1.1.6 Select COM Port connected to the actuator(s).

Figure 46 COM Port Selection 

 

Step 6

Lorem ipsum
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6.1.1.7 Select Baud Rate.

Figure 47 Baud Rate Selection 

 Step 7

DCMlink supports following Baud Rates: 1200, 2400, 4800, 9600, 19200, 38400, 57600, 115200.

6.1.1.8 Click Save (if there are no other preferred settings).

Figure 48 COM Port is Now Saved 

 

6.1.1.9 On Protocol Selection View (navigation pane), right-click on the newly created  
COM# Port.

6.1.1.10 Click on Scan For New Devices. Details on Network Scan can be found in Section 8.1.

NOTE:  

• COM port settings shall match with device(s)

 — The Baud rate, parity,  Stopbits shall match.

 — All devices connected to the same COM port shall use the same settings.

 — Use multiple COM ports incase if different settings are required.
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6.1.2 Configuring Communications in RDM Mode

The DCMlink fully supports the RDM slave mode connection with TEC2000 actuator.

6.1.2.1 For this, select the serial COM port number and select timeout delay as per actuator 
COM port settings.

NOTE:  

RDM Slave Mode is only available in TEC2000 actuator. DCMlink works with below settings in 
order to connect with TEC2000 in RDM mode.

 — Baud Rate: 9600

 — Parity: None

 — Stop Bits: 1

These parameters are fixed and cannot be modified by the user.

Figure 49 Modbus RDM Slave

 

6.1.2.2 Live Communication Viewer details are covered in Section 12.2.

NOTE:  

Once DCMlink is connected to TEC2000 in RDM Slave Mode it keeps polling even if the user 
closes status monitor/detailed setup, etc. DCMlink offers a provision for the user to enable or 
disable RDM polling in the background.
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6.1.3 Configuring Communications in Modbus TCP/IP

In Preference Settings, select the mode as Modbus TCP and enter the IP address and port 
number, timeout delay as per actuator port setting.

Figure 50 Modbus TCP

 

DCMlink will work with below settings in order to connect with Modbus TCP mode: 

• IP Address-Standard IP address format

• IP Port- Standard IP port number format

• Timeout Delay (Text Box)- 0-5000 (default: 100) 

Figure 51 Address Indication

IP address and IP Port 
number added under 

Modbus
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6.1.3.1 After the IP address and IP Port number added under Modbus in Navigation Pane will 
be displayed.

Figure 52 Address Indication (2)

 

IP address and IP Port 
number address under 

Modbus

6.1.4 To scan and identify a device connected to the Modbus TCP/IP, go through  
following steps:

6.1.4.1 Right-click on IP port address and select Scan for New Devices.

Figure 53 Scan for New Devices

6.1.4.2 On the Modbus Network Scan window, observe the start IP address, End IP address, 
and Port number which is similar to configured IP address under Modbus Tag in 
Navigation Pane.

6.1.4.3 Click Start.

6.1.4.4 Once the device is found, click Stop, followed by Close. 
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Figure 54 Device Tag

 

Device Tag

6.1.4.5 Notice that the device tag appears on the Navigation Pane.

6.1.4.6 Live Communication Viewer details are covered in Section 12.2.

NOTE:

In order to use Modbus TCP/IP, the user must have a CAM209/09 card.  
Default IP Address for CAM Card is: 192.168.1.192 and IP Port is: 502.
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6.2 Configuring Communication in XTE RS-232

This configuration is used in connecting XTE3000 over RS-232 protocol.

6.2.1 Configuring Communications in XTE RS-232.

6.2.1.1 From the menu bar, click DCMlink Setup.

6.2.1.2 Click Preferences.

Figure 55 
Step 1

Step 2

6.2.1.3 On Preferences window, click Communication tab.

6.2.1.4 Click preferred protocol and click Add.

NOTE:

XTE RS-232 is based on the DCMlink license that user has.

Figure 56 Steps 3 and 4

Step 3

Step 4
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6.2.1.5 Select COM Port connected to the actuator(s).

Figure 57 

Step 5

6.2.1.6 Select Baud Rate.

Figure 58 Baud Rate Selection

DCMlink supports following Baud Rates: 1200, 2400, 4800, 9600, 19200, 38400, 57600, 115200.
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6.2.1.7 Click Save (if there are no other preferred settings).

Figure 59 COM Port is Now Saved

6.2.1.8 On Protocol Selection View (navigation pane), right-click on the newly created  
COM# Port.

6.2.1.9 Click on Scan for New Devices. Details on Network Scan can be found in Section 8.1.

6.3 Configuring Communications in Bluetooth

DCMlink allows the detection and configuration of devices connected via Bluetooth. Using the 
Bluetooth device scanner in the navigation bar, the user can perform a device scan by following 
the steps and screenshots shown below.

NOTE:

• There is no setting required for Bluetooth, under preferences.

• The user needs to have Bluetooth enabled on their computer to allow the use of  
this function.

• The user can check if their computer has Bluetooth function enabled or not. If the 
bluetooth function is not present, please consult your system administrator or IT.
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6.3.1 On the Navigation pane, click Scan For New Devices. Details on this can be found  
in Section 8.1. 

NOTE:

• COM port settings shall match with device(s).

 — The Baud rate shall match. Only in case of XTE3000 if selected Baud rate does 
not match then it automatically try with next Baud rate.

 — User Name & Operator Name should be selected.

 — All devices connected to the same COM port shall use the same settings.

Figure 60 Scan for New Devices

6.3.1.1 On the XTE RS-232 Network Scan window, observe the Port number which is similar 
to configured COM Port under XTE RS-232 Tag in Navigation Pane.

6.3.1.2 Click Start.

6.3.1.3 Once the device is found, click Stop, followed by Close.

6.3.1.4 Notice that the device tag appears on the Navigation Pane.

6.3.1.5 Live Communication Viewer details are covered in Section 12.2.
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6.4 Configuring Communications in HART 

There are 4 different sections for HART Protocol:

• HART Modem

• HART MUX (Multiplexer)

• Wireless Network

• DeltaV Network

6.4.1 HART Modem

6.4.1.1 From the menu bar, click DCMlink Setup.

6.4.1.2 Click Preferences.

Figure 61 Preferences in Menu Bar

 

Step 1

Step 2

6.4.1.3 On the Preferences window, click Communication tab.

6.4.1.4 Click HART.

6.4.1.5 Click Add.

Figure 62 Communication with HART Mode 

     

Step 3

Step 5

Step 4
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6.4.1.6 Click on HART Mode and select option Modem.

Figure 63 Configuring HART Port through Modem 

 

Step 6

 

6.4.1.7 Select COM Port connected to the actuator. 
COM port listed will be only the HART Modems connected to computer.

Figure 64 COM Port Selection 

 

Step 7
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6.4.1.8 Baud rate is fixed at 1200. 

6.4.1.9 Select Master Type:

 – Primary: Primary master is communicating device, such as HART 
capable control system permanently wired to field instrument.

 – Secondary: Secondary master is not permanently wired to field 
instrument. A hand-held communicator or a HART modem attached to 
computer running DCMlink software typically communicates  
as secondary.

Figure 65 Master Type Selection  

 

Step 8

6.4.1.10 Parity is fixed at Odd.

6.4.1.11 Stop Bits is fixed at 1.

6.4.1.12 Timeout delay: Should be user editable text box the default value should be  
300 ms and the range should be 300 - 5000 ms.

Figure 66  

 
Step 11

Step 10

Step 9
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6.4.1.13 Multidrop Enabled: If selected should enable Multidrop otherwise it should be point 
to point communication with the address range of 0 to 63.

NOTE:  

In Multidrop Mode, current is fixed at 4 mA.

Figure 67  

 
Step 12

6.4.1.14 Click Save.  

Figure 68 COM Port is Now Saved 
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6.4.1.15 On Protocol Selection View (navigation pane), right-click on the newly created 
COM# Port.

6.4.1.16 Click Scan For New Devices.

Figure 69 Scan for New Devices 

 

6.4.1.17 View after HART Modem configuration. Details on Network Scan can be found in
Section 7.5.

Figure 70 View after HART Modem configuration.
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6.4.2 HART MUX (Multiplexer) Setting

6.4.2.1 From the menu bar, click DCMlink Setup.

6.4.2.2 Click Preferences.

Figure 71 Preferences in Menu Bar 

 

Step 1

Step 2

6.4.2.3 On Preferences window, click Communication tab.

6.4.2.4 Click on the HART protocol.

6.4.2.5 Click Add. 

Figure 72 Communication with HART Mode 

     

Step 3

Step 5

Step 4
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6.4.2.6 Click HART Mode and select option Multiplexer.  

Figure 73 Configuring HART Port through Multiplexer 

 

Step 6

6.4.2.7 Select COM Port connected to the actuator. 
COM Port is generated because of RS485 Modem.

Figure 74 COM Port selection 

 

Step 7
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6.4.2.8 Select Acceleration. 
High, Low, None

Figure 75 Acceleration selection 

 

Step 8

6.4.2.9 Baud rate: 
Available Baud rate is 9600, 19200, or 38400. 

Figure 76 Baud Rate selection 

 

Step 9
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6.4.2.10 Select Master Type:

 – Primary: Primary master is communicating device, such as HART 
capable control system permanently wired to field instrument.

 – Secondary: Secondary master is not permanently wired to field 
instrument. A hand-held communicator or a HART modem attached to 
computer running DCMlink software typically communicates  
as secondary.

Figure 77 Master Type selection  

 

Step 10

6.4.2.11 Parity is fixed at Odd.

6.4.2.12 Stop Bits is fixed at 1.

6.4.2.13 Should be user editable text box the default value should be 300 ms and the range 
should be 300 - 5000 ms.

Figure 78  

 

Step 13

Step 12

Step 11



User's Guide 
DCM-402-0818 Rev. 2.3 February 2020

55

Section 6: Configuring Preferences

Configuring Preferences

6.4.2.14 Scan for Multiplexer at address range. Add address range from 0 to 63.

NOTE:  

The Multiplexer address is used by DCMlink internally while detecting the connected 
Multiplexer in Network.

Figure 79  

 

Step 14

6.4.2.15 Click Save. 

Figure 80 COM Port saved 
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6.4.2.16 On Protocol Selection View (navigation pane), right-click on the newly created 
COM# Port.

6.4.2.17 Click Scan For New Devices.

Figure 81 Scan for New Devices 

 

6.4.2.18 View after HART MUX is configured. Details on Network Scan can be found in  
Section 7.5.

Figure 82 View after HART MUX configuration 

 

6.4.3 Wireless Network: This can be used in SNAP-ON mode only. For AMS SNAP-ON user  
launches DCMlink from AMS. No configuration is required in DCMlink preference.  
Make sure DCMlink SNAP-ON is installed on PC, please refer to Section 7.5.3. 

6.4.4 DeltaV Network: This can be used in SNAP-ON mode only. For AMS SNAP-ON user 
launches DCMlink from AMS. No configuration is required in DCMlink preference.  
Make sure DCMlink SNAP-ON is installed on PC, please refer to Section 7.5.4.
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6.5 Gauge Type (Analog/Digital)

DCMlink features two viewing options for gauges: Analog and Digital. The two viewing options 
will show the user the required information using a conventional gauge style for the analog and 
a seven-segment style display for the digital format. To change the default setting (analog) to 
digital, use following steps:

6.5.1 On the menu bar, click DCMlink Setup.

6.5.2 Click General tab.

6.5.3 Put a check mark on Digital Indicator (uncheck if desired display is analog).

6.5.4 Click OK.

6.5.5  While viewing the Tag indicators, click Close Tag on the bottom right.

6.5.6 Reselect the actuator Tag from the navigation pane and double-click.

6.5.7 The display shown on the indicators will now be of the selected format.

Figure 83 Analog Display
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Figure 84 Digital Display

 

6.6 Raw Value in Position Dial (for MPA only)

Option Preference for showing percentage (%) or raw value in Dial (MPA). This is applicable 
to the MPA only, and only for the Position Dial. By default, this check box shall be unselected 
(shown as %). User can opt to see Position in Raw Value format in Dial.

Figure 85 Raw Value in Position Dial (for MPA only)
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Figure 86 Raw Value Gauge Display

            

6.7 Change Network Parameter Settings

DCMlink allows the modification of communication settings. To change network parameters.

6.7.1 Use following steps:

6.7.1.1 From Menu Option DCMlink Setup.

6.7.1.2 Select Menu Option Preferences.

6.7.1.3 On Preferences window, select Communication Tab.

6.7.1.4 Select the Network Port.

6.7.1.5 Click on Property button.

6.7.1.6 Accordingly modify the parameters.

Figure 87 Changing Network Parameters 
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Section 7: Setting Up DCMlink Networks

7.1 Setup Modbus Network

NOTE:  

For Modbus, there are three types of connections available. First is the Modbus Master, second 
is RDM slave mode (only for TEC2000) and third one is TCP/IP (user needs CAM09/209 card). 
Refer to the following wiring connection to connect DCMlink to the respective actuator.

 CAUTION: TURN OFF POWER BEFORE WIRING
Before working on the wiring connections, power down the actuator.

1. For TEC2000

a. Separate Terminal Chamber (STC) contains terminal block for  
wiring connection.

b. Pinch bar to rotate the STC cover in a counter-clockwise direction, this will 
open the STC cover and the user will see the terminal block in STC.

Figure 88 TEC2000 Terminal Chamber 

 

Figure 89 Opening TEC2000 Terminal Chamber
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c. STC – With Terminal Block Numbering

Figure 90 Opened TEC2000 Terminal Chamber   

2. For TEC2 
Please refer to the following for different wiring connections:

a. For Modbus Master Mode:

 – Pin 39 to +Ve of RS485

 – Pin 41 to -Ve of RS485

 – Pin 40 to Ground of RS485 [Optional]

NOTE:

The pins above should be used only for the CAM205 or CAM228.  
For the TEC2, the recommended connection is  the dedicated DCMlink port. 
For more information on the pin layout, consult the TEC2 Instruction and Operation Manual.

Figure 91 Modbus Connection on STC
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b. For Modbus Master Mode (Using DCMlink dedicated pins). 
Another way to connect DCMlink with TEC2 is by  using DCMlink dedicated 
pins (36, 37, and 38). The following are the dedicated pin details:

 – Pin 36 to +Ve of RS485

 – Pin 38 to -Ve of RS485

 – Pin 37 to Ground of RS485 [Optional]

NOTE:

For this section "b" only, connection baud rate is 115200.

c. For Modbus Master Mode on HART CAM216:

 – Pin 39 to +Ve of RS485

 – Pin 40 to -Ve of RS485

7.1.1 After wiring the connections with the actuator, check the serial port number on PC. 
For this, right-click on My Computer and go to “Manage-> Computer Management  
-> System Tools -> Device Manager-> Ports -> Communication Port (Port Number)." 

3. For MPA

Table 6. CAM Card Pin Configuration

Without CAM05, or any other protocol  
CAM card

With CAM05, or any other protocol  
CAM card

Pin 19 is +Ve of RS485 Modem Pin 25 is +Ve of RS485 Modem
Pin 18 is -Ve of RS485 Modem Pin 24 is -Ve of RS485 Modem

Figure 92 MPA Modbus Connection 

 

19 (+Ve of RS485) 18 (-Ve of RS485) 
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4. For M2CP

 — Pin 25 is +Ve of RS485 Modem

 — Pin 24 is -Ve of RS485 Modem

Figure 93 M2CP Modbus Connection 

 

25 (+Ve of RS485) 24 (-Ve of RS485) 

5. For HQ Series

 — Pin 1 is -Ve of RS485 Modem

 — Pin 2 is +Ve of RS485 Modem

Figure 94 HQ DCM32 Modbus Connection (1)
1 (+Ve of RS485) 

2 (-Ve of RS485) 

 — Pin 1 is +Ve of RS485 Modem

 — Pin 2 is -Ve of RS485 Modem 
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Figure 95 HQ DCM33 Modbus Connection (2)
1 (+Ve of RS485) 2 (-Ve of RS485) 

6. For EHO

 – Pin 39 to +Ve of RS485

 – Pin 41 to -Ve of RS485

 – Pin 40 to ground of RS485 [Optional]

Figure 96 EHO Modbus Connection
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NOTE:

Details on the configuration of CAM09/209 is found on the document.

7. For XTE3000

 – Pin: A1+, A2-  OR

 – Pin: A5+, A6-

Figure 97 XTE3000 Modbus Connection

NOTE:

For XTE3000, the user will need the Modbus Bus Card. 

7.2 Modbus TCP/IP Settings

7.2.1 The user needs to use Modbus TCP/IP CAM card to utilize this feature.

NOTE:

For TEC2000 and TEC2 the user will need to use a CAM209 Card. 
For M2CP, MPA, EHO and HQ, the user will need a CAM09 Card. 

Figure 98 CAM209 Connected to TEC2000 Actuator
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7.3 RDM Connection Settings

The DCMlink fully supports the RDM mode connection with TEC2000 actuator.

7.3.1 For this, select serial COM Port number and select timeout delay as per actuator  
COM Port settings.

NOTE:  

RDM Slave Mode is only available for the TEC2000 actuator. 

7.3.2 DCMlink works with below settings to connect with TEC2000 in RDM mode:  
STC pin numbers:

• Pin 21 to +Ve of RDM Slave Mode

• Pin 23 to -Ve of RDM Slave Mode

• Baud Rate: 9600

• Parity: None

• Stop Bits: 1

These parameters are not allowed to be modified.

7.4 Setup Bluetooth Network

DCMlink allows the detection and configuration of devices connected via Bluetooth. Using the 
Bluetooth device scanner in the navigation bar, the user can perform a device scan by following 
the steps and screenshots shown.

NOTE:

The user needs to have Bluetooth enabled on computer to allow the use of this function. 
User can check if computer has Bluetooth function enabled or not. If the bluetooth  
function is not present, please consult the system administrator or IT.

7.4.1.1 On the navigation bar, the Bluetooth node will be populated. The name of the 
Bluetooth node in DCMlink will be the same as the name of the Bluetooth at the 
operating system level. The user cannot change the name of the Bluetooth name  
from the DCMlink, but it is possible to change this from the operating system.
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Figure 99 DCMlink Home Screen with Bluetooth 

Figure 100 Scanning the Bluetooth Network  

NOTE:  

After closing Tag or exiting from Setup mode & reopening the same tag, user needs to wait for 
couple of minutes to establish proper communication with Bluetooth device.
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7.5 Setup HART Network

7.5.1 Attaching HART Modem 

A HART modem is a communication device that allows DCMlink to communicate with the 
actuator. The following section provides necessary information for attaching the HART modem 
to the computer and actuator.

NOTE:  

HART modem drivers, needed for the HART modem to work, are installed during  
DCMlink installation.

7.5.1.1 HART Modem Installation for DCMlink SOLO

HART modem attaches to USB port usually found on the back of the computer or the serial port.

• Locate the serial port or USB port where modem will be connected. 

• Make note of the port where HART modem is attached. 

• Attach HART modem directly to the serial port, USB port, or to a cable connected to 
serial port or USB port.

• Use the modem cable assembly to connect HART modem to the actuator or to  
signal wiring.

• To communicate with actuator, locate the signal wires or the terminals of the actuator.

• Clip cable assembly to wires or terminals.

• Refer to document HART IOM for more information on using the HART modem.

7.5.1.2 HART Modem Installation for DCMlink SNAP-ON

The HART modem attaches to USB port usually found on the back of the computer or the  
serial port. 

• Locate serial port or USB port where modem will be connected. 

• To configure HART modem, refer to AMS manual.

http://www.emerson.com/documents/automation/180802.pdf
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Steps for installing stand-alone AMS:

Before adding DD to AMS, HART Modem on AMS needs to be configured. (Ensure that HART 
Modem drivers are already installed before configuring Modems on AMS). Follow steps below:

• Network Configuration:

 — Open Start Menu.

 — Click Programs.

 — Click AMS Device Manager.

 — Click Network Configuration.

Figure 101 Network Configuration 

 — Select Network Component Type and click Add.

 — For HART device: HART Modem.

Figure 102 Select Network Component Type  

 — Click Install and follow screen instructions.
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Figure 103 Add HART Modem Wizard-Start  

Figure 104 Add HART Modem Wizard-Modem Name  
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Figure 105 Add HART Modem Wizard-Network Controller  

 — Select one COM Port from the list.

Figure 106 Add HART Modem Wizard-Connection 
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Figure 107 Add HART Modem Wizard-Multi Drop  

 — When finished HART Modem will be shown on the Network  
Configuration Screen.

Figure 108 Network Configuration  
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7.5.2 Multiplexer Networks for DCMlink SOLO

7.5.2.1 Setting Up Multiplexer Network

DCMlink uses an RS485 Modem to communicate with different actuators through HART 
multiplexers. Depending upon the multiplexer, DCMlink can support up to 256 individual 
loop channels per multiplexer. Refer to Table 7 to determine the number of multiplexers and 
actuators that may be connected to a network.

Table 7. Maximum Number of Multiplexers and HART Devices per Network  

Multiplexer Type
Maximum Number 
of Multiplexers Per 
Network

Maximum Number of Loops Per 
Multiplexer      

MTL4841 Communications Module 31 256

Pepperl+Fuchs 32 255

Each MTL4841 module receives digital data from a maximum of 16 MTL4842 HART  
Interface Modules. In turn, each MTL4842 module accesses data from a maximum of 16 HART devices.

 

The following procedure to set up a multiplexer network:           

• Connect physical equipment. Set all multiplexers and the RS485 converter to the same 
baud rate. 

NOTE: 
For details about wiring and connecting equipment, refer to the appropriate instruction guide.

• Apply power to the RS485 converter, multiplexers and actuators.

• To configure DCMlink refer to Section 6.4.2 HART MUX (Multiplexer) setting.

7.5.2.2 Changing the Multiplexer Tag and Descriptor

Figure 109 Changing the Multiplexer Tag and Descriptor

Enter the name of the Multiplexer 
here. Same will be reflected in the 
DCMlink.
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7.5.2.3 Setting Up Pepperl+Fuchs Multiplexer

When adding or removing a submodule from a Pepperl+Fuchs multiplexer, user must 
reconfigure the multiplexer to indicate the changes. Multiplexer configuration changes are 
made from the Pepperl+Fuchs Module Setup screen, Figure 110.

To setup Pepperl+Fuchs Multiplexer:

• On each Pepperl+Fuchs slave module, Set Slave Address switch to an unused value so 
that each module has its own individual setting.

• On Pepperl+Fuchs Module Setup screen, check those modules that are installed.

Figure 110 Pepperl+Fuchs Module Setup Screen  

                                                        

7.5.2.4 Setting Up MTL Multiplexer

Figure 111 MTL Multiplexer  
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7.5.2.5 Viewing Multiplexers Status

User can view the status and add a tag and descriptor to each multiplexer on the network. For a 
Pepperl+Fuchs multiplexer, user can also define which modules are included in the multiplexer.

Figure 112 Multiplexer Information Window  

    

Multiplexer fields:

• Mux #: The multiplexer address, determined by the address switch settings on the 
multiplexer or communications module.

• Unique ID: The last six digits of a unique ID number assigned to the multiplexer by 
the manufacturer.

• Tag: A name assigned to the multiplexer from the tag and descriptor screen.

• Description: A description assigned to the multiplexer from the Tag and  
Descriptor  screen.

• Manufacturer: The multiplexer manufacturer, Emerson, MTL, ELCON, or P&F.

• Device Type: HART Interchange for a 2530H1 HART Interchange Multiplexer, MTL4841 
Communications Module for a MTL4840 HART Maintenance System, KFD HART. 
Multiplexer System for a Pepperl+Fuchs multiplexer, or an ELCON Mux.

• Univ. Command Rev.: The HART command language revision number, always 5.

• Instr. Command Rev.: The multiplexer or communications module firmware  
revision number.

• Scanning: Alert scanning. Should always be disabled when not viewing the Network 
Scan window.

• Scan Cmd: HART command level returned to the multiplexer or communications 
module by the instrument if an alert occurs. May be a1 or a3.

• Date: The date data was entered.

• Message: A message programmed into the multiplexer or communications  
module software.

• Gender: Whether the multiplexer or communications module is a primary master or 
secondary master.
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• Loop Search: Currently the multiplexer or communications module only searches for 
single analog loops, those loops where the instrument polling address is 0.

• Gateway Device: HART signaling scheme. Always RS485 - Bell 202.

• Software Rev.: Revision number of the software installed in the multiplexer or 
communications module.

• Hardware Rev.: Hardware revision level.

• Retry Count: Number of times multiplexer or communications module attempts to 
send a command to the instrument. Should be 2 after initialization.

7.5.2.6 Adding Actuator to Multiplexer 

NOTE:

DCMlink Solo must be licensed with a Tag Limit sufficient for the number of connected actuators.  

Depending upon the multiplexer, DCMlink Solo can support up to 256 individual loop channels 
per multiplexer. User can connect one actuator to each loop channel.

To add a new actuator to a multiplexer:

• Connect HART signal wiring to the multiplexer.

• Apply power to the actuator and multiplexers.

• Right click the multiplexer symbol and select Reset and Rescan the Multiplexer 
from the drop-down menu.

• If the actuator is recognized by the software, actuator symbol appears beneath 
the multiplexer on the device connection diagram. If no symbol appears, then the 
software does not recognize the actuator. Check physical connections and actuator 
loop power.

Figure 113 Adding Actuator to Multiplexer 
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7.5.3 Setup Wireless Network

7.5.3.1 Wireless Gateway

 — Set Up Gateway Internet Access for AMS Session

NOTE:

A special CROSSOVER CABLE must be used for this application.

• Connect crossover Ethernet cable between computer and Ethernet #1 port on Gateway.

• On PC navigate to: Control Panel > View Network Connections >Local Area 
Connection > Properties > Internet Protocol Version 4 (TCP/IPv4) > Properties.

• Select Use the following IP Address and enter 192.168.1.12 (subnet mask will come up) 
select Ok and then Ok on the next prompt.

• Open Internet Explorer and enter the following address: HTTPS://192.168.1.10 and hit 
enter. (*If Security certificate message comes up, you may have to select  Diagnose 
Connection Problem).

• Select Continue to Website and enter for Username admin and Password default.

• Select Explorer in left margin to read devices (this process might take up to 15 minutes).

 — Set up a computer using a HART Modem

• Install all software/drivers necessary for HART modem prior to connection.

• Open AMS Device Manager and navigate to Configuration > Add > HART Modem 
>Install > Next > Next and select Hand held device as secondary HART master, then 
select the correct COM port for HART modem.

• Go to Wireless HART adapter block and check include Wireless HART adapter then 
click finish.

7.5.3.2 Wireless THUM

 — THUM Programming – Join to Gateway Network Using a PC

Using the Wireless HART THUM Kit (Part No 87263), set up the THUM as shown below:

• Set up computer internet for Gateway.

• Plug HART modem into computer.

• Open AMS and navigate to Device Connection icon > HART modem > THUM > to 
read the parameters.

• Select Configure > Join Device to Network > Enter Network ID and enter the 
Network ID inside the cover of the Gateway, click next.

• Enter Join Key (Number shown on THUM Tag). All Three remaining Join Keys are (8) zeros.

• Select Network Configuration on AMS menu and select Add.

 — Running AMS to Change the Device Setpoint.

• Navigate and start your AMS Device Manager application.

• Locate and select the Device Connection View in the middle of the toolbar.

• Double click Wireless Network to see devices. 
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NOTE:

The message Network disruption was detected means no devices are sensed by  
gateway. If no devices show up on the screen, right click on Wireless Network and select  
Rebuild and Identify hierarchy.

• Expand Gateway > myNet > THUM and double click on the device Logo.

• Set Time in the lower left hand corner of the screen to Current from the drop down 
box select Yes when prompted to continue.

• Expand Online on the Configure/Setup Screen > Detailed Setup > Valve Control 
>Setpoint and select the Change Setpoint method.

• Select Yes and click next when the writing wetpoint requires placing the device in out 
of service mode... Prompt shows up.

• Enter the desired setpoint for the device and click Next.

• After receiving the write setpoint success message, select next, then finish to 
complete the change setpoint method.

7.5.3.3 Installation of Optional THUM Wireless Adapter

1. Component Installation on M2CP

Table 8. Attach wires from the Wireless HART THUM to the CAM16 J4  
 

CAM 16 THUM

I- White

I+ Yellow

Table 9. Connect Wireless THUM to 320B Board  
 

320B THUM

26 Red

29 Black

2. Component Installation on HQ

Table 10. Connect Wireless THUM to CAM16  
 

CAM 16 THUM

I- White

I+ Yellow

Table 11. Connect Wireless THUM to DCM33 Board  
 

HQ THUM

P3-3 Red

P3-4 Black
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3. Component Installation on TEC2000/TEC2

Table 12. Connect Wireless THUM to Actuator  
 

TEC2000 STC THUM

9 Red

10 Black1200 Ohm Series Resistor

24 Green (Optional)

43 Yellow

44 White

4. Connect to XTE3000 Actuator

Table 13. 

SW5 Pin 1 SW5 Pin 2 SW5 Pin 3 SW5 Pin 4 Connections Mode

OFF OFF ON ON Point to Point

OFF OFF ON ON Split Ranging

ON ON OFF OFF Multidrop

Figure 114 
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7.5.4 Setup DeltaV Network

• Connect actuator, DeltaV HART Network. 

• Using DeltaV Explorer navigate to actuator. 

Figure 115 DeltaV Explorer  

• Right click on the actuator and from Context menu user can launch AMS. Once AMS is 
launched, actuator can be seen under Navigation view of AMS.

Figure 116 Actuator on AMS  

• User can now launch DCMlink. 



February 2020
User's Guide 

DCM-402-0818 Rev. 2.3

82

Section 7: Setting Up DCMlink Networks

Setting Up DCMlink Networks

7.6 Multiplexer Networks for DCMlink SNAP-ON

For MUX Connections refer to Section 7.5.2. Once connection is completed with MUX, user 
needs to configure AMS. To configure AMS:

Figure 117 Network configuration  

 — Select Network Component Type and click Add. 

 — For HART device: HART Modem. 

Figure 118 Select Network Component Type  

 — Click Install and follow screen instructions.
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Figure 119 Add HART Modem Wizard-Start 
 

Figure 120 Add HART Modem Wizard-Modem Name 
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Figure 121 Add HART Modem Wizard-Network Controller 
 

 — Select one COM Port from the list.

Figure 122 Add HART Modem Wizard-Connection 
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Figure 123 Add HART Modem Wizard-Multi Drop 
 

 — When completed you will see a HART Modem added into the Network 
Configuration Screen.

Figure 124 Network Configuration  
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7.7 AMS SNAP-ON Setup 

AMS SNAP-ON is a software application that is installed as an integral part of AMS Device 
Manager to extend its functionality. AMS SNAP-ON adds the diagnostic test capabilities of 
DCMlink software to AMS Device Manager.

A USB hardware key is not used for installing AMS DCMlink SNAP-ON. However, AMS Device 
Manager must be licensed for the AMS DCMlink SNAP-ON. 

To install AMS DCMlink SNAP-ON, user must first have installed a properly licensed copy of AMS 
Device Manager.

7.7.1 User Setup 

 — Installing DCMlink SNAP-ON.

 — Starting AMS DCMlink SNAP-ON.

  CAUTION
Do not run DCMlink SOLO at the same time when using AMS Device Manager or AMS  
DCMlink SNAP-ON. Running both simultaneously may cause communication errors.

NOTE:

To successfully use DCMlink SNAP-ON, user must be familiar with using AMS Device Manager. 
Refer to the AMS online User’s Guide.

• To make DCMlink SNAP-ON work on AMS 12.5 or below,  please ensure to add 
Computer-Name (DCMlinkUser) as the domain and and password (DCMlink@123) 
to the AMS User Manager dialog. After adding the user to the AMS, make sure to add 
groups and select all groups for the DCMlinkUser, followed by granting of permissions.  
See below for a screen capture. 

• For AMS 13.0 and above, add user login to AMS User Manager dialog. This will launch 
AMS 13.0 and above using the user login credentials directly from the system.
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Figure 125 AMS Device Manager - User Manager

• Start AMS Device Manager by selecting Start> Programs > AMS > AMS system from 
the Windows taskbar.

• The AMS Explorer or Device Connection View window displays.

• AMS displays the communication devices (modem, multiplexer) that are connected to 
the PC running AMS and the AMS DCMlink SNAP-ON. Right-click device icon and select 
Scan All Devices to locate connected HART instruments.

Figure 126 AMS Device Manager Device Connection View  
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• When actuator icon appears, right-click the actuator icon and select SNAP-ON/Linked 
Apps > DCMlink from the context menu.

Figure 127 Right-Click Communications Device Icon to Open Menu  

7.7.2 Licensing 

For AMS to show DCMlink SNAP-ON as an option please contact AskPSS@emerson.com valid 
license is required to activate this feature. 

mailto:AskPSS%40emerson.com?subject=
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7.8 Setup Foundation™ Fieldbus Network

The use of FOUNDATIONTM fieldbus in DCMlink will available in a future version.

7.9 Troubleshooting Communication Issues

Table 14. Communication Issues Question and Answer Table

Section Question and Answer
Serial Ports Question: 

DCMlink software does not detect all of my serial ports.  
How do I enable DCMlink Software to use a port that it doesn’t automatically detect?
Answer: 
In the PreferenceSetting.XML file, ModbusSettings section, user can add a entry for 
ModbusSetting. 
If the user makes this change while DCMlink Software is running, the user will have to exit and 
restart the software for this change to take effect.

COM Port Question: 
DCMlink Software isn’t detecting the COM port. What could be causing this problem?
Answer: 
Close DCMlink and relaunch application. If the problem persists, restart the computer. 
Alternatively, the user can try programs, such as Allen Bradley or competitive valve suppliers, 
etc., that may be using the COM port.
Other causes may include:
The power saving option is set and has caused the port to use the low power option.  
You need to set the power saving to none and delete and reinstall the COM port.
The COM ports hardware is malfunctioning. To solve this, please contact your System 
Administartor.

Communication 
Errors in DCMlink

Question: 
I am getting communication errors when performing operations with DCMlink. What can 
I do to fix the errors?
Answer:
In the PreferenceSetting.XML file, ModbusSetting section, try changing the value of delay 
[Timeout delay]. If you make this change while DCMlink Software is running, the user will have 
to exit and restart the software for this change to take effect.
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8.1 Scan for New Devices in Modbus Master Mode

After a COM Port has been configured in Modbus, the user may begin scanning for installed 
electric actuators in the network. Follow the below:

8.1.1 On Protocol Selection View (navigation pane), right nmnmclick newly created Modbus  
COM# Port.

8.1.2 On the context menu, click Scan For New Devices.

Figure 128 Scan for New Devices

 

8.1.3 On the Modbus Network Scan Window, enter number in the Polling Range field.  
This number should be the address of the actuator. In the example on the next page, 
the TEC2000 device is in Polling Address Number 1.

NOTE:

Each electric actuator model series is indicated by a unique color. This feature aims to make 
it easier to detect multiple actuators across a wide address range in the scan device window. 
Please ensure that Polling Address w.r.t. Actuator gives Complete Colour blinking during  
network scanning process. This will ensure the stable communication.
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Figure 129 New Device Detected 

 

TEC2000 actuator detected 
at address 1

8.1.4 Click Stop on the device scanner once the device has been detected. Click Close. 

8.1.5 Click New Device Tag on the navigation pane to view the actuator.

Figure 130 TEC2000 Detected 

 

8.1.6 Live Communication Viewer details are covered in Section 12.2.

NOTE:

Live Communication Viewer details are required for Modbus Master. In order to use Modbus 
Master, the user needs a CAM card.
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8.2 Check Network for Actuators in Modbus RDM 
Slave Mode

TEC2000 actuator communicates with Remote Display Module (RDM) using few special custom 
Modbus commands. If any software can simulate the behavior of RDM (in terms of those 
custom modbus commands), TEC2000 will treat that software application as a physical RDM 
and will continue to communicate with it. This allows DCMlink to behave like a RDM and talk to 
TEC2000. User can use, connect, and control TEC2000 actuator.

Below explains the available RDM Mode options and the various parts of the application window.

NOTE:  

RDM Slave Mode is only available in TEC2000 actuator. 
Do not modify these parameters in the application.

About RDM Slave Mode:

• In RDM Slave Mode, DCMlink detects TEC2000 always at address 0.

• In RDM Slave Mode, DCMlink acts as RDM slave and TEC2000 actuator acts as Master.

8.2.1 Right click RDM port node to access the following context menu:

Figure 131 Scan for New Devices Using RDM Slave Mode 

 

Scan for New Devices
(in RDM Slave Mode)
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8.2.2 On the Network Scan Window, click Start.

Figure 132 Network Scan Window Using RDM Slave Mode

 

8.2.3 RDM Mode does not require specifying an address. User just needs to start scanning 
for actuators. 

 — As DCMlink work on address: 0.

 — No need for the user to choose the device address.

 — In RDM slave mode, DCMlink will act as RDM (Slave) and the TEC2000 actuator 
acts as a Master.

8.2.4 The detailed setup of RDM Mode actuator:

Figure 133 Detailed Setup in RDM Slave Mode  
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8.2.5 Whenever there is a change in any configuration parameters, the arrow button will be 
enabled as shown below:

Figure 134 Enabled Left and Right Arrows

 

• The Send arrow button allows the user to write data to the actuator. It also allows 
writing all changed data at a time, to the actuator.

• The Sync Dataset arrow button allows the user to write data from actuator to 
DCMlink dataset.

• The Read button is used to read all parameter values (actuator and dataset) from the 
detailed setup.

NOTE:

For RDM mode, Setpoint is not present on Status Monitor, Valve Control, and Trend Screen.

8.3 Check Network for Actuators in Modbus  
TCP/IP Mode

Below is about Modbus TCP/IP and its implementation into DCMlink. The details of Modbus 
TCP/IP is explained in this section.

8.3.1 In DCMlink Preference settings, select mode as Modbus TCP and select the IP address, 
port number, and timeout delay as per the actuator's TCP/IP setting. For more 
information on how to access the dialog box shown below, refer to Section 7.2.1.

8.3.2 To scan and identify a device connected to the Modbus TCP/IP, follow the below:

8.3.2.1 From the DCMlink, right-click on IP port address and select Scan for  
New Devices.

Figure 135 IP and Port Address from the Navigation Pane
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8.3.2.2 On the Modbus Network Scan window, observe the start IP address, End IP address, 
and Port number which is similar to configured IP address under Modbus Tag in 
Navigation Pane.

8.3.2.3 Click Start.

8.3.2.4 Once the device is found, click on Stop then click Close.

Figure 136 Detected Actuator at Specified Address

8.3.2.5 Notice that the device Tag appears on the navigation menu pane.

Figure 137 Detected Actuator in the Navigation Pane
 

Device Tag
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8.4 Check Network for Actuators in Bluetooth

8.4.1 From the DCMlink, right-click Bluetooth sub-item in the navigation bar and select Scan 
for New Devices.

Figure 138 Bluetooth Scan 

8.4.2 Provide the address of the actuator and click Start.

Figure 139 Device Address Input
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8.4.3 Select the detected Bluetooth device.

Figure 140 Detected Devices

 

NOTE:

Applicable to TEC2 actuator.
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Figure 141 

NOTE:

Applicable to XTE3000 actuator.

8.4.4 Click Connect.

8.4.5 Click Close to see the connected actuator on navigation view.

8.4.6 Live Communication Viewer details are covered in Section 12.2.

NOTE:

Bluetooth option is available in TEC2 and XTE3000.
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8.5 Check Network for Actuators in HART

There are 4 different sections for HART Network

• HART Modem 

• HART MUX (Multiplexer) 

• Wireless Gateway

• DeltaV 

8.5.1 For Modem and MUX refer to below procedures (for SOLO):

• In Preference settings, select mode as HART and configure HART Modem /MUX as 
per Section 7.5.1.1.

• To scan and identify device connected to the HART Modem as below:

 – From the DCMlink, right-click HART Modem.

 – Select Scan for New Device.

Figure 142 Scan for New Device

 – Click Start.

 – Once the device is found, click Stop, followed by Close.
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Figure 143 Detected Actuator at Specified Address 

 

 – You can find Device Tag on the Navigation Pane.

Figure 144 Detected Actuator in the Navigation Pane

 

Device Tag

8.5.2 For Modem (for SNAP-ON) refer to Section 7.5.1.2 and for MUX (for SNAP-ON) refer  to 
Section 7.6.

8.5.3 For Wireless Gateway and DeltaV  (for SNAP-ON) refer to Section 7.5.3  and 7.5.4.
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8.6 Check Network for Actuators in  
XTE RS-232 Protocol

After a COM Port has been configured for XTE RS-232, the user may begin scanning for installed 
electric actuators in the network. Follow the below:

8.6.1 On Protocol Selection View (navigation pane), right-click newly created XTE RS-232 
COM# Port.

8.6.2 On the context menu, click Scan for New Devices.

Figure 145 Scan for New Devices

NOTE:

Each electric actuator model series is indicated by a unique color. This feature aims to make 
it easier to detect multiple actuators across a wide address range in the scan device window. 
Please ensure that Polling Address w.r.t. Actuator gives Complete Colour blinking during  
network scanning process. This will ensure the stable communication.
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Figure 146 New Device Detected

8.6.3 Click Start on the device scanner to detect the connected device.

8.6.4 On device scanner, first it tries with the configured Baud Rate the with another  
baud rate.  Once device it connected, notifies the user with which Baud Rate 
connection was established.

8.6.5 Click Stop on the device scanner once the device has been detected. Click Close.

8.6.6 Click New Device Tag on the navigation pane to view the actuator.

Figure 147 XTE3000 Detected

8.6.7 Live Communication Viewer details are covered in Section 12.2.
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Section 9: Status Monitor 

9.1 Introduction

DCMlink menu options offer a wide range of features to customize the software experience and 
control installed actuators.

9.2 View Monitor Information

9.2.1 View Monitor Information

Figure 148 View Buttons
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Table 15. Status Parameters

Parameter
Device Status

Good Degraded Bad

Setpoint
If “Degraded”, “Bad” is not 
active, then the Status is Good

If the Value returned from 
Actuator > 4095
XTE3000:  If the Value 
returned from Actuator > 1000

If there is Communication Failure with the Actuator

Position
If “Degraded”, “Bad” is not 
active, then the Status is Good

If the Value returned from 
Actuator > 4095
XTE3000:  If the Positioner 
Sensor alarm is set.

If there is Communication Failure with the Actuator

Torque
If  “Degraded”, “Bad” is not 
active, then the Status is Good

If the Value returned from 
Actuator > 4095
XTE3000: 
If the: “Hi Hi Torque in open 
direction”
OR
“ Hi Hi Torque in close 
direction” alarm is set.

If there is Communication Failure with the Actuator

Analog Input 1
If “Degraded”, “Bad” is not 
active, then the Status is Good

If "Analog Input 1 Out of Range 
Alarm" is SET

a) If “Lost Analog Input 1 Alarm” is SET 
Or
b) If there is Communication Failure with the 
Actuator

Analog Input 2
If “Degraded”, “Bad” is not 
active, then the Status is Good

If "Analog Input 2 Out of Range 
Alarm" is SET.

a) If “Lost Analog Input 2 Alarm” is SET
Or
b) If there is Communication Failure with the 
Actuator

Analog Output 1
If “Degraded”, “Bad” is not 
active, then the Status is Good

If the Value returned from 
Actuator > 4095

If there is Communication Failure with the Actuator

Analog Output 2
If “Degraded”, “Bad” is not 
active, then the Status is Good

If the Value returned from 
Actuator > 4095

If there is Communication Failure with the Actuator

Hydraulic 
Pressure

If “Degraded”, “Bad” is not 
active, then the Status is Good

Hydraulic Pressure range 
change as per its unit as follow:
Pressure Unit Range-
bar: 0-400
psi: 0-5000
Kilopascal(kPa): 0-35000 

Depending Upon the unit 
following is the Status of 
Hydraulic Pressure:
Good- 0-5000
Degraded-  >5000
Bad- If “Over Pressure in Mid 
Travel Alarm"

If there is Communication Failure with the Actuator

Accumulator 
Pressure

If “Degraded”, “Bad” is not 
active, then the Status is Good

Pressure Unit Range-
bar: 0-400
psi: 0-5000
Kilopascal(kPa): 0-35000 

Depending Upon the unit 
following is the Status of 
Accumulator Pressure
Good- 0-5000
Degraded-  >5000
Bad- If “Over Pressure in Mid 
Travel Alarm” 

If there is Communication Failure with the Actuator
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9.2.2 Dashboard (Maximize, Restore, Minimize)

Figure 149 View Buttons

 

Restore, Minimize, 
and Maximize buttons

a. Maximize: Selected window maximizes the screen.

Figure 150 Maximize

b. Undock: Turns the selected window into a movable window. Click and drag  
to move. (Third window shown below is now movable).

Figure 151 Undock
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c. Minimize: Collapses the selected windows showing only the top window bar.

Figure 152 Minimize  

d. Trend: Shows the torque graph readings.

Figure 153 Trend View

 

 – Zoom In: Magnifies a particular portion the graph, showing lines in 
greater detail.

 – Zoom Out: Reduces the magnification on the graph.

 – Zoom Back: Moves zoom magnitude to the original setting.

 – Grid: Shows trend graph grid.

 – Legend: Toggles Setpoint, Position and Travel on top of the graph.
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NOTE:

Zoom in and zoom out works when status monitoring has stopped.

9.2.3 Monitor: Shows the discrete values shown in the graph.  

Figure 154 Monitor Tab

9.2.4 Alarms: Shows applicable alarms for the selected actuator. 

 CAUTION: PAY ATTENTION TO DCMLINK ALARMS
DCMlink monitors the status of the plant infrastructure. If warnings and cautions show up in 
status alerts, a device needs urgent attention or is providing important information.  
Carefully monitor alarms and alerts to allow for immediate action.  
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Figure 155 Alarms Tab

 

NOTE:

If there is any active alarm, the TAB Color will be red.

Figure 156 Alarms Legend

 

• Red Cross: Alarm is active.

• Green Tick: No Alarm is active.

• Grey Circle: Alarm is disabled.
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The following is a summary of alarms applicable to the actuator device type:

Table 16. Application of Alarms for Actuator Device Type (1)

Alert
Alert  

Sub-bit

Applicable to Actuator Type
Alert  

Information

MPA
M2CP 
(320B)

HQDCM32/ 
HQDCM33

TEC2000 TEC2 EHO State of the Problem Recommended Action

Actuator 
Fail 

Alarm
N/A Yes Yes N/A Yes Yes Yes

A device has failed due to 
an internal self-test of the 
actuator.

1. Cycle power to the 
actuator to clear this alarm.
2. If power cycling did not 
clear this alert, immediate 
actuator maintenance is 
required on the contactor, 
position detector, and motor 
or power circuit.
3. Please check the 
connection between Pin #20 
and Pin #22 on STC (this is 
applicable only for  
TEC family).

Phase 
Monitor 

Alarm
N/A Yes Yes N/A Yes Yes Yes

The actuator has failed 
because the phase monitor 
indicated a loss of one 
phase or reversed phase 
rotation of incoming  
three-phase power.

1. Verify if the manifold 
valves are in the proper 
position. Reverse phase  
is non-fatal whereas the lost 
phase shall be addressed.  
For TEC family, (TEC2000/
TEC2/EHO) and MPA the 
phase monitor is always 
enabled. For M2CP, this 
feature is optional and the 
jumper on the TBM can be 
configured to enable/disable 
phase correction.
2. Check the incoming power 
supply to the actuator.

Motor 
Thermal  

Alarm
N/A Yes Yes N/A Yes Yes Yes

A device failure because 
the motor control circuit 
is disabled due to motor 
overheating or motor 
overload relay (optional) 
has tripped.

1. The motor has 
overheated due to 
operating the motor 
beyond the recommended 
starts or duty cycle. Another 
cause may be a seized valve 
that will not allow the motor 
to turn (motor stall).
2. Let the motor cool, 
look for any obstructions 
and examine your control 
strategy to make sure you 
are not overloading  
the motor.

Power 
Monitor 

Alarm
N/A Yes Yes N/A Yes Yes Yes

This alert indicates a 
device failure due to loss 
of control voltage to  
the motor.

Check fuse F3  to clear 
alarm. (This is applicable 
only for M2CP actuator).
For TEC Family: 
1. It indicates flaw in 
functionality of contactor.
2. Occurrence of power 
monitor alarm indicates 
failure to operate 
contactors, hence valve will 
not move.
3. Cable between CCM 
and MCM can have a loose 
connection, change cable.
4. Problem in MCM,  
change MCM.
5. Connector on CCM board 
can be bad, change CCM.
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Table 17. Application of Alarms for Actuator Device Type (2)

Alert
Alert 

Sub-bit

Applicable to Actuator Type
Alert  

Information

MPA
M2CP 
(320B)

HQDCM32/ 
HQDCM33

TEC2000 TEC2 EHO State of the Problem Recommended Action

Moving 
Wrong 

Direction
N/A Yes N/A N/A N/A N/A N/A

The actuator was 
turning in the  
wrong direction.

1. This alarm may occur on a 
three-phase model due to a 
hardware failure. The wiring 
in the TBM (Terminal Board 
Module) or the wiring to the 
contactor (or the contactor 
itself), or the position 
detector may have failed. 
2. Immediate actuator 
service is required on the 
actuator as this alarm locks 
out all further movement to 
prevent damaging the seals.

Hardware 
Fault Alarm

CCM Failure 
Alarm

N/A N/A N/A Yes Yes N/A

Central Control Module 
has detected an error 
indicating an internal 
failure.

Please check the connection 
between Pin #20 and 
Pin #22 on STC (This is 
applicable only for TEC 
family).
Please contact Emerson or 
your local representative.

LDM Failure 
Alarm

N/A N/A N/A Yes Yes Yes

Local Display Module 
has detected an error 
indicating an  
internal failure.

Please contact Emerson or 
your local representative.

APD Failure 
Alarm

N/A N/A N/A Yes Yes N/A
Absolute Position 
Detector Failure.

Please contact Emerson or 
your local representative.

RDM1 
Failure 
Alarm

N/A N/A N/A Yes Yes Yes

Remote Display 1 
failure. Remote display 
has been enabled in 
the configuration, 
and either the RDM 
is not present, or has 
communication errors.

Please contact Emerson or 
your local representative.

RDM2 
Failure 
Alarm

N/A N/A N/A Yes Yes Yes

Remote Display 2 
failure.  Remote display 
has been enabled in the 
configuration and either 
the RDM is not present, 
or has communication 
errors.

Please contact Emerson or 
your local representative.

Hydraulic 
Power Unit 
Fault Alarm

N/A N/A N/A N/A N/A Yes

The alarm indicates the 
hydraulic power unit 
failure. Triggered when 
the motor ran for more 
than 4 seconds but 
hydraulic pressure has 
not increased.

Please contact Emerson or 
your local representative.

Solenoid 
Valve Fault 

Alarm
N/A N/A N/A N/A N/A Yes

This alarm indicates  
SOV failed.

Please contact Emerson or 
your local representative.

Pressure 
Transmitter 
Fault Alarm

N/A N/A N/A N/A N/A Yes
The alarm indicates 
pressure transmitter 
failed.

Please contact Emerson or 
your local representative.

Encoder 
Fault Alarm

N/A N/A N/A N/A N/A Yes

Encoder indicates 
the position value 
is incorrect due to 
communication error in 
encoder circuit.

Please contact Emerson or 
your local representative.
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Table 18. Application of Alarms for Actuator Device Type (3)

Alert
Alert  

Sub-bit

Applicable to Actuator Type
Alert  

Information

MPA
M2CP 
(320B)

HQDCM32/ 
HQDCM33

TEC2000 TEC2 EHO State of the Problem Recommended Action

Fieldbus 
CAM card 

specific 
alarms

Communication 
Failed Alarm

Yes Yes Yes Yes Yes Yes

A device 
failed because 
communication 
between the Fieldbus 
Interface and 
actuator has failed or 
has an error due to 
data integrity.

1.Communication failure 
may occur when the 
actuator is powered 
down such as when 
maintenance is being 
performed.
2. Check the 
communication integrity 
from the Fieldbus 
Interface to the actuator 
and if the actuator  
is powered.

Actuator Lost 
Power Alarm

Yes Yes Yes Yes Yes Yes

Electronic 
Failure

Electronics fault 
alarm

N/A N/A N/A Yes Yes N/A
Internal hardwired 
system failure  
of electronics.

Reset power. If alarm 
reoccurs, Please contact 
Emerson or your local 
representative.

ROM Integrity 
Failure

Yes Yes Yes Yes Yes Yes

Mfg. Blk. 
Integrity Failure

Yes Yes Yes Yes Yes Yes

Initialization 
Failed Alarm

Yes Yes Yes Yes Yes Yes

The Fieldbus Interface 
cannot communicate 
with the actuator or 
the upload/download 
generates an error.

1. When the Fieldbus 
Interface goes through 
a Reset, either by 
cycling power or via the 
Resource Block Reset 
parameter, it attempts 
to download/upload 
initialization data to/from 
the actuator.
2. This alert will clear 
after the Fieldbus 
Interface initializes 
communication with the 
actuator.

Compatibility 
Error

Yes Yes Yes Yes Yes Yes

NV Memory 
failure

Yes Yes Yes Yes Yes Yes

Nonvolatile EEPROM 
data corruption was 
detected on the 
Fieldbus Electronic 
board.

1. Check the device 
configuration for changes 
in the block parameter 
values.
2. Reset the device to 
clear the error.
3. Download a device 
Configuration.
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Table 19. Application of Alarms for Actuator Device Type (4)

Alert
Alert  

Sub-bit

Applicable to Actuator Type
Alert  

Information

MPA
M2CP 
(320B)

HQDCM32/ 
HQDCM33

TEC2000 TEC2 EHO State of the Problem Recommended Action

Over 
Pressure in 
Mid-Travel 

Alarm

N/A N/A N/A N/A N/A N/A Yes

This alert indicates 
that the hydraulic 
pressure has 
exceeded the 
archived pressure 
value and pressure 
value tolerance level 
(%) in the  
open direction.

1. Check the archived 
Hydraulic Pressure value. 
Also, check to ensure 
there is no obstruction 
preventing the actuator 
from making a full open 
stroke. 
2. Running the actuator 
in the opposite direction 
successfully will clear this 
alarm.

Analog 
Input Out 
of Range 

Alarm

AI-1 Out of 
Range

N/A Yes Yes Yes Yes Yes

Analog input to the 
actuator is beyond 
the legal limits of the 
input channel.

1. Check the 4 - 20 
mA source.  Check the 
4 - 20 mA cabling and 
connection. 
2. Try Analog calibration 
procedure on the actuator 
using the same 4 - 20 mA 
source.

AI-2 Out of 
Range

N/A Yes N/A Yes Yes N/A

Over 
Torque 
Alarm

Close Torque N/A Yes Yes Yes Yes Yes

The close torque 
limit has exceeded its 
value the last time the 
actuator attempted 
to move in the  
close direction.

1. Check the close torque 
limit settings to ensure 
proper set up. Also, check 
to ensure there is no 
obstruction preventing the 
actuator from making a 
full close stroke.
2. Running the actuator 
in the opposite direction 
successfully will clear this 
alarm.

Open Torque N/A Yes Yes Yes Yes Yes

The open torque 
has exceeded the 
configured value in 
the open direction.

1. Check the open torque 
limit settings to ensure 
proper set up.  
2. Also, check to ensure 
there is no obstruction 
preventing the actuator 
from making a full open 
stroke.
3. Running the actuator 
in the opposite direction 
successfully will clear this 
alarm. 

Over Torque Yes N/A N/A Yes Yes Yes
The torque has 
exceeded the  
torque limit.

1.Check the torque limit 
setting to ensure proper 
set up. 
2. Also, check to ensure 
there is no obstruction 
preventing the actuator  
from moving.
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Table 20. Application of Alarms for Actuator Device Type (5)

Alert
Alert  

Sub-bit

Applicable to Actuator Type
Alert  

Information

MPA
M2CP 
(320B)

HQDCM32/ 
HQDCM33

TEC2000 TEC2 EHO State of the Problem Recommended Action

Overshoot 
Alarm

N/A Yes N/A N/A N/A N/A N/A

This condition is 
reported when the 
valve crossed the 
target port and the 
valve must go all 
the way around. 
After 3 retries, 
this alarm will be 
triggered indicating a 
maintenance issue.

1. Check if the flow 
selector has no fluid at all, 
resulting in very  
little torque.
2. The actuator may 
require calibration to be 
performed by a qualified 
technician.

Stop 
Between 

Ports 
Alarm

N/A Yes N/A N/A N/A N/A N/A
The actuator has 
failed to move to the 
commanded port.

1. This alert occurs 
when the actuator is 
power-cycled while it is 
moving. This alert can 
also occur if the selector 
knob is switched to the 
“off” position while the 
actuator is moving.
2. Immediate actuator 
maintenance is required 
on the TBM (Terminal 
Board Module), contactor, 
position detector, motor 
or power circuit. Also 
ensure the clutch is not in 
the hand position.

CPU Has 
Reset

N/A N/A Yes Yes Yes Yes Yes

This alarm indicates 
that the CPU has 
reset due to power 
cycle. Additionally, 
for TEC2 and EHO 
actuators, this alarm 
also indicates a 
request to restart the 
processor from host 
has been executed 
successfully.

This alarm will remain 
on until cleared from the 
Host.

Config 
Conflict 

Error

Config Conflict 
Error

N/A Yes Yes Yes N/A N/A

Actuator has 
been incorrectly 
configured, or 
hardware sanity 
checks do not 
match the actuator 
configuration 
settings.  Internal 
system corruption of  
control board.

1. Check power.
2. Check that the actuator 
settings are configured 
correctly for the installed 
actuator.
3. Check the connection 
between Pin#20 and 
Pin #22 on STC (This is 
applicable only for TEC 
family) If the issue is not 
resolved, Please contact 
Emerson or your local 
representative.

Invalid SOV 
configuration 

Alarm
N/A N/A N/A N/A N/A Yes

This alarm indicates 
SOV configuration is 
in correct during  
Self-Calibration.

Check the SOV 
configuration and  
self-calibrate the actuator. 
It will clear the alarm 
once Self-Calibration is 
completed successfully.
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Table 21. Application of Alarms for Actuator Device Type (6)

Alert
Alert  

Sub-bit

Applicable to Actuator Type
Alert  

Information

MPA
M2CP 
(320B)

HQDCM32/ 
HQDCM33

TEC2000 TEC2 EHO State of the Prolem Recommended Action

Valve Drift 
Alarm

N/A N/A N/A N/A Yes Yes Yes

Movement has been 
detected that was 
not initiated from 
the motor running. 

Make sure the actuator 
is not in the handwheel 
position.

Low Battery 
Alarm

N/A N/A N/A N/A Yes Yes N/A

The actuator has 
detected a  
low charge voltage 
on the internal Super 
CAP/Battery.

1. Check the charge 
volTage because the Super 
CAP has fallen below a 
predetermined voltage, 
indicating that the Super 
CAP is not sufficiently 
charged.
2. Actuator maintenance 
is required if this alert 
persists for more than 
four hours after power is 
applied to the actuator.

Limits Not 
Set Alarm

N/A N/A N/A N/A Yes Yes Yes

This alarm indicates 
that the fully open 
and fully close limits 
are not configured.

For TEC family of 
actuators, limits can be 
configured from the Local 
Display Module (LDM). 
For the M2CP family of 
actuators, please refer 
to the corresponding 
DIP switch settings to 
configure the limits.

Accumulator 
Alarm

Accumulator 
Pre Charge 

Alarm
N/A N/A N/A N/A N/A Yes

The accumulator 
nitrogen pre-charge 
is not within the  
set range. 

Refer to the  
pre-charge instructions 
in the information 
package and add or 
subtract nitrogen to the 
accumulator accordingly.  
Immediate service is 
required to ensure proper 
functionality of the unit.

Accumulator 
Charge Fault 

Alarm
N/A N/A N/A N/A N/A Yes

The accumulator did 
not charge to the 
maximum pressure 
within the allowed 
charge time. The 
electric motor has 
been stopped until 
another command  
is received.

Refer to the maintenance 
instructions for reasons 
and solutions to resolve 
this issue.  Immediate 
service is advised to ensure 
proper functionality of 
the unit.

Low Oil 
Level Alarm

N/A N/A N/A N/A N/A N/A Yes

This alarm indicates 
oil level in hydraulic 
tank is less. However, 
this alert does not 
prevent actuator 
operation.

Once oil is filled in the 
tank, this alert will  
be cleared.

Inhibit 
Alarm

Close Inhibit 
Alarm

N/A N/A N/A Yes Yes Yes
Actuator has been 
configured to use 
the discrete inputs 
as inhibits and one 
of them is currently 
active. When active, 
this alarm will inhibit 
actuator from 
moving.

Check the host system. 
Check external control 
wiring and connections. 
Clear the inhibit conditions 
on the host.

Open Inhibit 
Alarm

N/A N/A N/A Yes Yes Yes
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Table 22. Application of Alarms for Actuator Device Type (7)

Alert
Alert  

Sub-bit

Applicable to Actuator Type
Alert  

Information

MPA
M2CP 
(320B)

HQDCM32/ 
HQDCM33

TEC2000 TEC2 EHO State of the Problem Recommended Action

Lost COM 
Alarm

Lost COM1 
Alarm

N/A Yes N/A Yes Yes Yes

This alarm indicates 
that the network 
communications  
has failed.

Check the network 
cables. Check the 
network connections 
on the STC. Check the 
BAUD rate on the host.  
Check if the host is 
operating.

Lost COM2 
Alarm

N/A Yes N/A Yes Yes Yes

This alarm indicates 
that the network 
communications  
has failed.

Check the network 
cables. Check the 
network connections 
on the STC. Check the 
BAUD rate on the host. 
Check if the host is 
operating.

ESD 
Active 
Alarm

ESD from 
Lost COM

N/A N/A N/A N/A N/A N/A N/A N/A

Hardwired 
ESD Alarm

Yes Yes Yes Yes Yes Yes

An open circuit 
(or closed circuit, 
depending on 
configuration) to the 
Local ESD input of  
the actuator.

1. ESD input overrides 
control of the actuator 
as long as the ESD 
condition exists. The 
actuator will go to a 
pre-selected position of 
close, open or stay put.
2. Clear the local ESD by 
supplying the normal 
signal (open/closed 
circuit, depending on 
the configuration) to  
the actuator. 

Host 
Command 

ESD
Yes Yes Yes Yes Yes Yes

This alarm indicates 
that the host has sent 
an ESD command to 
the actuator.

This alarm will remain 
on until it is cleared 
from the Host.

Lost 
Analog 
Input 
Alarm

Lost Analog 
Input 1

N/A N/A N/A Yes Yes Yes

This alarm is triggered 
when the analog 
input 1 signal is not 
present and the 
actuator is configured 
for analog control.

Check analog cable.  
Check connections on 
Analog Input on the 
STC.  Check if the analog 
input source is valid.

Lost Analog 
Input 2

N/A N/A N/A Yes Yes N/A

This alarm is triggered 
when the analog 
input 2 signal is not 
present and the 
actuator is configured 
for analog control.

Check analog cable.  
Check connections on 
analog input on the STC.  
Check that the analog 
input source is valid.

Backup 
Power 
Alarm

N/A N/A N/A Yes N/A N/A N/A

This alarm indicates 
the actuator has 
detected a low 
charge voltage on the 
internal Super CAP.

Actuator maintenance 
is required if this alarm 
persists for more than 
four hours after power is 
applied to the actuator.

Valve 
Stall 

Alarm
N/A Yes Yes Yes Yes Yes Yes

The actuator has 
stalled for more 
than 10 seconds 
while moving to the 
commanded position.

1. Run the actuator in 
the opposite direction 
(except MPA) to clear 
this alarm.
2. Check the contactor, 
position detector, clutch 
and the motor.

Partial  
Stroke 

Test Fail 
Alarm

N/A N/A N/A N/A N/A N/A Yes

This alarm is reported 
when the partial 
stroke test was not 
successful.

Alarm will get cleared 
when a new partial 
stroke test is successful.

Check 
Function

N/A Yes Yes Yes Yes Yes Yes
Transducer block is 
not in auto mode.

Check transducer  
block mode.
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Table 23. Application of Alarms for XTE3000 Actuator Device Type (1) 

Alert XTE3000
Alert Information

State of the Problem Recommended Action

Motor Thermostat Yes
Motor thermostat open for high 
temperature in the motor windings

Wait until the motor cools down

Hi Hi Torque in open direction Yes
Measured torque greater than the 
relevant value configured in torque set-up 
or stroke limits routine

Operate the actuator in closing
direction. Check the torque
needed to operate the valve

Hi Hi Torque in close direction Yes
Measured torque greater than the 
relevant value configured in torque set-up 
or stroke limits routine

Operate the actuator in opening
direction. Check the torque
needed to operate the valve

Blocked in open Yes Not used

Blocked in close Yes Not used

Hi Hi temperature Yes
Temperature inside the actuator
enclosure higher than 90 °C or lower
than -40 °C

Ambient temperature too high or
too low. Verify insulation among
actuator and heat source

Position Sensor Yes Value of the actuator position not valid
Replace position sensor or
recalibrate both stroke limits

Speed Sensor Yes Measure of motor speed not valid Replace speed sensor

Main Voltage Yes
Main voltage lower than -20% or
higher than +20% of the value stated in
the name plate menu

Check main voltage supply and
frequency on terminals L1, L2, L3.
Check that wires section is correct

K1 Contactor Yes
The test routine reports a failure of K1
(coil or auxiliary contact)

Check the contactor

K2 Contactor Yes
The test routine reports a failure of K2
(coil or auxiliary contact)

Check the contactor

Configuration Error Yes
The checksum of the EEPROM
memory that contains the
configuration data is wrong

Reconfigure all parameters  
(see details next page)

Hardware Error Yes
The diagnostic program detects
some malfunction in the electronics
controlling the actuator

Some circuit is damaged and does
not work (see details next page)

Low Battery Yes

The voltage of the lithium battery is
too low (only detected if the lithium
battery is present and the relevant
parameter of the miscellaneous
routine is set to “present”)

Change lithium battery

Lost Phase Yes

The alarm appears only with 3-phase
main supply. The alarm is generated
in case of fault of one of the phases
that supply the actuator transformer

Check main power supply on
terminals L1, L2, L3

Request Signal Yes The analog 4 - 20 mA signal is not correct
Check the external 4 - 20 mA
generator and wiring

Max Torque intermediate position Yes
The valve does not move in presence
of an open/close control

Control in opposite direction

Jammed in close Yes
No position change after receiving a
CLOSE control

Check status of actuator and valve
mechanical parts

Jammed in open Yes
No position change after receiving an 
OPEN control

Check status of actuator and valve

Direction Test fail Yes Motor rotates in the wrong direction Check the motor wiring

Mid travel in open Yes
The valve does not move in presence
of an open control

Check status of actuator and valve
mechanical parts. Recalibrate
both stroke limits

Mid travel in close Yes
The valve does not move in presence
of a close control

Check status of actuator and valve
mechanical parts. Recalibrate
both stroke limits



User's Guide 
DCM-402-0818 Rev. 2.3 February 2020

117

Section 9: Status Monitor

Status Monitor

9.2.5 Warnings

Figure 157 Warnings for XTE3000

Table 24. Warnings 

Warnings XTE3000
Warning Information

State of the Problem Recommended Action

Hi Hi Torque in  
open direction

Yes
Measured torque 10% lower than the relevant value 
configured in torque set-up or stroke limits routines

Check the torque necessary to
move the valve

Hi Hi Torque in  
close direction

Yes
Measured torque 10% lower than the relevant value 
configured in torque set-up or stroke limits routines

Check the torque necessary to
move the valve

Hi Hi Temperature Yes
Temperature inside the actuator enclosure higher than 80 °C 
or lower than -35 °C

Find the heat source and  
insulate the actuator

Main Voltage Yes
Value of the main voltage out of the correct range  
(-15% or +10% of the value stated in the name plate menu) or 
wrong frequency

Check section of wires and  
values of voltage and frequency

Contactor Cycles Yes Max. number of contactor cycles reached
Change contactor and reset
operation log

Maintenance request Yes Date of the next maintenance reached
Perform maintenance and set 
nextmaintenance date

Motor current Yes Motor current greater or lower than limits Check electrical motor

Wrong stroke limits Yes
The routine that monitors the stroke limits detects a wrong 
end of travel condition

Recalibrate both stroke limits

PST Error – Max T1 Yes

During the last PST, the T-PST time measured is greater than 
or lower than the “MAX T-PST”  of the T-PST measured during 
the Baseline PST.
“MAX T-PST” is configurable from 1 – 1000%

Generate a new successfully PST

PST Error – Max T2 Yes

During the last PST, the T-RET time measured is greater than 
or lower than the “MAX T-RET”  of the T-RET measured during 
the Baseline PST.
“MAX T-RET” is configurable from 1 – 1000%.

Generate a new successfully PST

PST Error – OverTravel Yes
During the last PST, the position travel is greater than the 
“MAX OV-TR”
“MAX OV-TR” is configurable from 1 – 100

Generate a new successfully PST

PST Error – PST Failed Yes
At least two of “PST-Max T1”, “PST- Max T2”, “OV-TR” are 
active or after a device reset

Generate a new successfully PST

General Warning Yes Almost one warning is active All warning must be cleared
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9.2.6 Temperature

Figure 158 Temperature

9.2.7 Input/Outputs 
Actuator specific details are available in the respective actuator IOM.

Figure 159 Input/Outputs Tab



User's Guide 
DCM-402-0818 Rev. 2.3 February 2020

119

Section 9: Status Monitor

Status Monitor

NOTE:

If any discrete input or relay is high, the tab color will turn red.

Figure 160 Status Monitor Alarms Legend

 

 — Red Cross: Means discrete input/relay is high/set.

 — Green Tick: Means discrete input/relay is low/reset.

 — Grey Circle: Means discrete input/relay is disabled.

9.2.8 ESD/Inhibits 
Displays the related ESD alarms and relay status. 

Figure 161 ESD Inhibits Tab

Figure 162 ESD Inhibit Alarms Legend 

 — Red Cross: Means alarm is active.

 — Green Tick: Means no alarm is active.

 — Grey Circle: Means alarm is disabled.
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9.2.9 Device 
The Device Tab shows detailed information about the selected actuator.  
The information found here varies per actuator model. 

Figure 163 Device Tab

 

 — Tag Name: Tag unique ID.

 — Serial Number: Actuator serial number.

 — Model: Actuator model type.

 — Manufacture Date: Date actuator was manufactured.

 — Actuator Type: Actuator type, such as multi-turn, quarter turn etc. 

 — Network Adapter: Network adapter for the DCS.

 — Network Address: Actuator network address.

 — APD Gear Ratio: Absolute Position Detector (APD) records the position calibration of 
the actuator. This information shows the gear ratio used by the APD.

 — Motor: Motor ID.

 — Voltage: Voltage of selected actuator.

 — Starter: Type of starter mechanism.

 — Worm Gear: Worm gear orientation.

 — Drive Sleeve: Displays drive sleeve.

 — Reverse Rotation:  Shows a (Yes/No) if the actuator rotates in reverse.
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9.2.10 Logs 
The Logs tab shows operation-related information regarding the selected actuator. 
Information such as total run time, starts, strokes and others are to be found here.

Figure 164 Logs Tab
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Section 10: Detailed Setup

10.1 Introduction

DCMlink reduces commissioning time with simplified configuration screens that are easy to 
navigate and provide clarity over each parameter. 

The Detailed Setup View is a function that allows the user to monitor and control the 
numerous aspects of the managed electric actuator. Using this part of DCMlink, users can see 
the current configuration prior to downloading the new data, without having to remember 
what is in the device. Easy navigation buttons allow synchronization at each parameter level, 
page level or the entire configuration. 

DCMlink allows configuration settings to be stored and archived for later use or for the purpose 
of export to a central database or import to another device.

Detailed setup view can be accessed by clicking on the corresponding detailed setup icon in 
the tool bar as shown below.

NOTE:

Detailed Setup can be launched primarily by right-clicking on the actuator Tag on the  
navigation pane and clicking Detailed Setup. The second way of launching is to click the tool 
bar icon for Detailed Setup. The third way of doing detailed setup involves clicking on the  
menu bar item Actuator Setup and then accessing the item for Detailed Setup. It should be 
noted, however, that the second and third methods will only be available when the Tag is open 
(such as valve control, status monitor, and factory settings are open).

Figure 165 Detailed Setup Icon

Detailed Setup View
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Figure 166 Detailed Setup from the Context Menu

 

Detailed Setup 

The Detailed Setup View after launching.

Figure 167 Detailed Setup After Launching

 

4

1 2

5

3
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1. Left arrow button 
Left arrow is used to update data from DCMlink dataset to actuator.

2. Right arrow button 
Right arrow updates the actuator data to DCMlink user interface. 

NOTE:

The data that is written from actuator to dataset using right arrow button would go to  
the database.

 — If there is any difference, between the dataset value and actuator value, the 
arrow button will appear with the blue color, as shown in the image below:

Figure 168 Colored Left and Right Arrows

 

 — If there is no difference, then the arrow button will appear in gray color,  
as shown in below image:

Figure 169 Gray Left and Right Arrows

 

3. Change tab color to yellow

 — If there is any difference in value from actuator and dataset then the tab will be 
highlighted in yellow:

Figure 170 Yellow Tabs in Detailed Setup
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 — If there is no any difference then there will be no change in tab color:

Figure 171 No Highlighted Tabs in Detailed Setup 

 

4. Read Button 
The Read button is present on the upper right hand corner for detailed setup. 
Whenever Read is clicked, it will read the entire parameter data from DCMlink.

5. Read Entire Configuration/Page 
Two options available:

 — Entire configuration: Whenever the user select this option and clicks on Read, 
it will read all the parameters from the detailed setup tab.

 — Page: Whenever the user selects this option and clicks on Read, it will read 
only the particular tab page parameters from the detailed setup screen.

Figure 172 Configuration Page Options
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6. Save Dataset 
Refer to Section 18.5.5 for details.

7. Reset Dataset  
Refer to Section 18.5.7 for details.

8. Delete Dataset  
Refer to Section 18.5.6 for details.

9. Copy from Tag 
Refer to Section 18.5.8 for details.

10. Load Configuration

 — Configuration button will provide an option to select a configuration file to 
load/open on DCMlink. 

 — The following file types from the legacy applications are supported:

Table 25. Import Configuration Supported File Extensions

Actuator Type File Extension

TEC family *.cfg  OR  *.TEC

M2CP *.cfg  OR  *.320AB

HQDCM32 *.cfg  OR  *.HQDCM32

HQDCM33 *.cfg  OR  *.HQDCM33

MPA *.cfg  OR  *.MPA

XTE3000
*.cfg (for Modbus only), *.icon OR *.xte  
(for bluetooth only),  
*.hart (for HART only)

 — After uploading is complete, it will load all the datasets available on 
configuration file. This gives information to the user on the settings available 
on the configuration file.

NOTE:

If the settings/configuration inside the configuration file is different than the current actuator, 
the tab color will turn yellow. And the send/receive button will be enabled.

11. Export Configuration

 — Whenever the user clicks on the export configuration button, it will save the 
current configuration into a file which the user can load/open on DCMlink. 

 — Default path of the open file dialog will be C:\Users\[user name]\Desktop.
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10.2 Configure Parameters 

DCMlink has the capability to make various configurations for different actuator parameters. 
Listed below are the three primary areas in which different configurations are made. 

NOTE:

Please put the actuator in Setup Mode first before changing configuration parameters in 
TEC2000. As TEC2000 takes some time to enter into Setup Mode, the write configuration  
command sent during actuator transition to Setup Mode may fail.

10.2.1 Actuator Setup 
On menu bar, Actuator Setup features:

a. Clock Sync 
This will synchronize the actuator clock with the computer clock.

Figure 173 Clock Sync 

Figure 174 Synchronize Clock Window 
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b. Clear CPU Reset 
This will clear CPU reset alarm.

Figure 175 Accessing Clear CPU Reset 

 

Figure 176 Clear CPU Reset Window 

c. Clear ESD 
This will clear the ESD alarm active in the actuator.

Figure 177 Accessing Clear ESD 
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Figure 178 Clear ESD Window

d. Wink/Squawk 
This sends Wink/Squawk command to the Actuator. Wink option is available 
for XTE3000 actuator and Squawk option is available for both TEC2 and EHO  
actuators. User can Launch Wink/Squawk command window from Menu   
Option Actuator Setup -> Actuator Action -> Wink.

Figure 179 Sending Wink/Squawk Command

e. Reset to Factory 
This sends Reset to factory command to the Actuator.  User can Launch Reset  
to factory command window from Menu Option Actuator Setup -> Actuator  
Action -> Reset to Factory.

Figure 180 Sending Reset to Factory Command
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f. RS-232 Baud Rate Settings 
This option is only available for XTE3000 actuator.

 — Baud rate could be set to either 115200 or 9600.

User can Launch RS-232 Baud Rate Settings window from Menu Option Actuator Setup -> 
Actuator Action -> RS-232 Baud Rate Settings.

Figure 181 Setting RS-232 Baud Rate Settings

10.2.2 Actuator Mode 
In Modbus Master Mode, Actuator Mode allows the user to enter and exit setup 
mode. In Modbus RDM Slave Mode, the user can switch between all the modes of the 
actuator and other modes:

 — Remote Mode

 — Local Mode  

 — Stop/Off Mode

 — Setup Mode

NOTE:

Actuator Mode Dialog can be opened or launched when actuator monitoring is inactive.
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Figure 182 Accessing Actuator Mode 

Figure 183 Actuator Mode Window 
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10.2.3 Detailed Setup 
Primarily accessed via the tool bar or by right-clicking on the actuator Tag in the 
navigation window, Detailed Setup features a wide array of functions and tabs that 
allow the following configurations:

10.2.4 Control 
The Detailed Setup features an array of drop-down options for control mode.  
Features below:

Figure 184 Control Tab 

 

Figure 185 Drop-down Options for Control Tab View 
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Table 26. Drop-down Options Selection for Control Tab

Parameter Dataset Option

Control

DI Two-Wire

DI Three-Wire

DI Four-Wire

IrDA

Three-Wire Analog Selectable

Analog

Network

Remote Control Signal
Maintained

Momentary

Local Control Signal
Maintained

Momentary

Seating
Position

Torque

Backseat
Position

Torque

LED Color
Open Green / Close Red

Open Red / Close Green

Close Torque Limit (Numeric Percentage Value)

Open Torque Limit (Numeric Percentage Value)

Enable RDM 1 Yes / No

Enable RDM 2 Yes / No

Enable Log Jam Yes / No

Enable Low Battery Alarm Yes / No

Enable Setpoint Tracking Yes / No

Ignore 3% Torque Pullout Yes / No

NOTE:

If the user enables or disables Bluetooth communication with the device may be lost.
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10.2.4.1 Discrete Input

Figure 186 Discrete Input Tab 

 

 — Save Dataset 
Refer to Section 18.5.5 for details.

 — Reset Dataset  
Refer to Section 18.5.7 for details.

 — Delete Dataset  
Refer to Section 18.5.6 for details.

 — Copy From Tag: Copies configuration from an existing Tag. 

 — Load Configuration: Loads a configuration from an existing configuration file 
for input to actuator.

 — Export Configuration: Collects the current configuration and saves it as a file 
in the target directory.

10.2.4.2 Maintenance for XTE3000

Figure 187 Maintenance for XTE3000

NOTE:

The above functions also apply to other tabs in the detailed setup view.
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 — The discrete inputs table for each actuator series listed below:

Table 27. TEC2000

Discrete Input Function Setting

1 1 = Open/Host Control
1 = Active on Open Contact
0 = Active on Close Contact

2 2 = Close/Host Control
1 = Active on Open Contact
0 = Active on Close Contact

3 3 = Stop/PST Input/Host Control
1 = Active on Open Contact
0 = Active on Close Contact

4 4 = Open Inhibit/Host Control
1 = Active on Open Contact
0 = Active on Close Contact

5 5 = Close Inhibit/Host Control
1 = Active on Open Contact
0 = Active on Close Contact

6 6 =Hardwired ESD/Host Control
1 = Active on Open Contact
0 = Active on Close Contact

NOTE:

For MPA, there is no discrete input available.

Table 28. M2CP

Discrete Input Function Setting

1 1 = Open/Host Control NA

2 2 = Close/Host Control NA

Table 29. HQDCM33

Discrete Input Function Setting

1 Close/Host Control NA

2 Stop/PST Input/Host Control NA

Table 30. TEC2

Discrete Input Function Setting

1 1 = Open/Host Control
1 = Active on Open Contact
0 = Active on Close Contact

2 2 = Close/Host Control
1 = Active on Open Contact
0 = Active on Close Contact

3 3 = Stop/PST Input/Host Control
1 = Active on Open Contact
0 = Active on Close Contact

4 4 = Open Inhibit/Host Control
1 = Active on Open Contact
0 = Active on Close Contact

5 5 = Close Inhibit/Host Control
1 = Active on Open Contact
0 = Active on Close Contact

6 6 = Hardwired ESD/Host Control
1 = Active on Open Contact
0 = Active on Close Contact
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Table 31. EHO

Discrete Input Function Setting

1 1 = Open/Host Control
1 = Active on Open Contact
0 = Active on Close Contact

2 2 = Close/Host Control
1 = Active on Open Contact
0 = Active on Close Contact

3 3 = Stop/PST Input/Host Control
1 = Active on Open Contact
0 = Active on Close Contact

4 4 = Host Control
1 = Active on Open Contact
0 = Active on Close Contact

5 NA NA

6 6 = Hardwired ESD/Host Control
1 = Active on Open Contact
0 = Active on Close Contact

10.2.4.3 Relays 
The relays tab shows the current state of relays in the actuator and also shows 
the datasets, which can be configured and loaded to the actuator.

Figure 188 Relays Tab 

 

Figure 189 Drop-down Options for Relay Tab 
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Table 32. Drop Down Options for Relay Tab

Parameter Dataset Option

Relay (#)

Limit Switch Open (LSO)

Limit Switch Close (LSC)

Limit Switch A (LSA)

Limit Switch B (LSB)

Opening

Closing

Open Torque Alarm

Close Torque Alarm

Local Mode

Stop Mode

Remote Mode

Valve Drift Alarm 

Power Monitor Alarm 

Phase Monitor Alarm

Motor Thermal Alarm

Open Inhibit Alarm

Close Inhibit Alarm

Hardwired ESD Alarm

ESD Active Alarm

Analog Input Control Alarm

Actuator Fail Alarm

Host Control 

Electronics Fault Alarm

Moving

Over Torque Alarm

Valve Stall Alarm

Low Battery Alarm 

Monitor Alarms

Setting

NC Continuous

NC Flashing

NO Continuous

NO Flashing
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 — The relay functions table for each type of relay and actuator is listed below:

Table 33. TEC2000 Relay 1

Relay Function Setting

1

0 = Limit Switch Open (LSO)
1 = Limit Switch Close (LSC)
2 = Limit Switch A (LSA)
3 = Limit Switch B (LSB)
4 = Opening
5 = Closing
6 = Open Torque Alarm
7 = Close Torque Alarm
8 = Local Mode
9 = Stop Mode
10 = Remote Mode
16 = Valve Drift Alarm
17 = Power Monitor Alarm
18 = Phase Monitor Alarm
19 = Motor Thermal Alarm
20 = Open Inhibit Alarm
21 = Close Inhibit Alarm
22 = Hardwired ESD Alarm
23 = ESD Active Alarm
24 = Analog Input Control Alarm
25 = Actuator Fail Alarm
26 = Host Control
27 = Electronic Fault Alarm
28 = Moving
29 = Over Torque Alarm
30 = Valve Stall Alarm
31 = Low Battery Alarm
32 = Monitor Alarms

0 = NC Continuous
1 = NC Flashing
2 = NO Continuous
3 = NO Flashing

Table 34. TEC2000 Relay 2

Relay Function Setting

2

0 = Limit Switch Open (LSO) 
1 = Limit Switch Close (LSC) 
2 = Limit Switch A (LSA) 
3 = Limit Switch B (LSB) 
4 = Opening 
5 = Closing 
6 = Open Torque Alarm 
7 = Close Torque Alarm 
8 = Local Mode 
9 = Stop Mode 
10 = Remote Mode 
16 = Valve Drift Alarm 
17 = Power Monitor Alarm 
18 = Phase Monitor Alarm 
19 = Motor Thermal Alarm 
20 = Open Inhibit Alarm 
21 = Close Inhibit Alarm 
22 = Hardwired ESD Alarm 
23 = ESD Active Alarm 
24 = Analog Input Control Alarm 
25 = Actuator Fail Alarm 
26 = Host Control
27 = Electronic Fault Alarm 
28 = Moving 
29 = Over Torque Alarm 
30 = Valve Stall Alarm 
31 = Low Battery Alarm 
32 = Monitor Alarms 

0 = NC Continuous
1 = NC Flashing
2 = NO Continuous
3 = NO Flashing
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Table 35. TEC2000 Relay 3

Relay Function Setting

3

0 = Limit Switch Open (LSO) 
1 = Limit Switch Close (LSC) 
2 = Limit Switch A (LSA) 
3 = Limit Switch B (LSB) 
4 = Opening 
5 = Closing 
6 = Open Torque Alarm 
7 = Close Torque Alarm 
8 = Local Mode 
9 = Stop Mode 
10 = Remote Mode 
16 = Valve Drift Alarm 
17 = Power Monitor Alarm 
18 = Phase Monitor Alarm 
19 = Motor Thermal Alarm 
20 = Open Inhibit Alarm 
21 = Close Inhibit Alarm 
22 = Hardwired ESD Alarm 
23 = ESD Active Alarm 
24 = Analog Input Control Alarm 
25 = Actuator Fail Alarm 
26 =Host Control
27 = Electronic Fault Alarm 
28 = Moving 
29 = Over Torque Alarm 
30 = Valve Stall Alarm 
31 = Low Battery Alarm 
32 = Monitor Alarms 
33 = PST- (Partial Stroke Test) Pass

0 = NC Continuous
1 = NC Flashing
2 = NO Continuous
3 = NO Flashing
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Table 36. TEC2000 Relays 4 and 5

Relay Function Setting

4

0 = Limit Switch Open (LSO) 
1 = Limit Switch Close (LSC) 
2 = Limit Switch A (LSA) 
3 = Limit Switch B (LSB) 
4 = Opening 
5 = Closing 
6 = Open Torque Alarm 
7 = Close Torque Alarm 
8 = Local Mode 
9 = Stop Mode 
10 = Remote Mode 
16 = Valve Drift Alarm 
17 = Power Monitor Alarm 
18 = Phase Monitor Alarm 
19 = Motor Thermal Alarm 
20 = Open Inhibit Alarm 
21 = Close Inhibit Alarm 
22 = Hardwired ESD Alarm 
23 = ESD Active Alarm 
24 = Analog Input Control Alarm 
25 = Actuator Fail Alarm 
26 = Host Control
27 = Electronic Fault Alarm 
28 = Moving 
29 = Over Torque Alarm 
30 = Valve Stall Alarm 
31 = Low Battery Alarm 
32 = Monitor Alarms 
33 = PST (Partial Stoke Test) Fail

0 = NC Continuous
1 = NC Flashing
2 = NO Continuous
3 = NO Flashing

5
26 decimal = Host Control
32 decimal = Monitor Alarms
35 decimal = Unit Alarm

6 = Continuous 
7 = flashing

NOTE:

For MPA, there is no relay available.

Table 37. M2CP

Relay Function Setting

1

41 = ESD (Change request)
10 = Remote Mode
8 = Local Mode
2 = Limit Switch A (LSA)

4 = Normally Open Contact
5 = Normally Closed Contact

2

23 = ESD Active Alarm
10 = Remote Mode
8 = Local Mode
3 = Limit Switch B (LSB)

4 = Normally Open Contact
5 = Normally Closed Contact

5
40 = Monitor 
26 = Host Control
41 =  ESD 

NA

NOTE:

For HQ32/33, there is no relay available.
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Table 38. TEC2 Relay 1

Relay Function Setting

1

0 = Limit Switch Open (LSO) 
1 = Limit Switch Close (LSC) 
2 = Limit Switch A (LSA) 
3 = Limit Switch B (LSB) 
4 = Opening 
5 = Closing 
6 = Open Torque Alarm 
7 = Close Torque Alarm 
8 = Local Mode 
9 = Stop Mode 
10 = Remote Mode 
16 = Valve Drift Alarm 
17 = Power Monitor Alarm 
18 = Phase Monitor Alarm 
19 = Motor Thermal Alarm 
20 = Open Inhibit Alarm 
21 = Close Inhibit Alarm 
22 = Hardwired ESD Alarm 
23 = ESD Active Alarm 
24 = Lost Analog Input 1 Alarm 
25 = Lost Analog Input 2 Alarm  
26 = Host Control 
28 = Moving 
29 = Over Torque Alarm 
30 = Valve Stall Alarm 
31 = Low Battery Alarm 
32 = Monitor Alarms
33 = N/A
34 = Actuator Fail Alarm

0 = NC Continuous
1 = NC Flashing
2 = NO Continuous
3 = NO Flashing

Table 39. TEC2 Relay 2

Relay Function Setting

2

0 = Limit Switch Open (LSO) 
1 = Limit Switch Close (LSC) 
2 = Limit Switch A (LSA) 
3 = Limit Switch B (LSB) 
4 = Opening 
5 = Closing 
6 = Open Torque Alarm 
7 = Close Torque Alarm 
8 = Local Mode 
9 = Stop Mode 
10 = Remote Mode 
16 = Valve Drift Alarm 
17 = Power Monitor Alarm 
18 = Phase Monitor Alarm 
19 = Motor Thermal Alarm 
20 = Open Inhibit Alarm 
21 = Close Inhibit Alarm 
22 = Hardwired ESD Alarm 
23 = ESD Active Alarm 
24 = Lost Analog Input 1 Alarm 
25 = Lost Analog Input 2 Alarm  
26 = Host Control 
28 = Moving 
29 = Over Torque Alarm 
30 = Valve Stall Alarm 
31 = Low Battery Alarm 
32 = Monitor Alarms
33 = N/A
34 = Actuator Fail Alarm

0 = NC Continuous
1 = NC Flashing
2 = NO Continuous
3 = NO Flashing



February 2020
User's Guide 

DCM-402-0818 Rev. 2.3

142

Section 10: Detailed Setup

Detailed Setup

Table 40. TEC2 Relay 3

Relay Function Setting

3

0 = Limit Switch Open (LSO) 
1 = Limit Switch Close (LSC) 
2 = Limit Switch A (LSA) 
3 = Limit Switch B (LSB) 
4 = Opening 
5 = Closing 
6 = Open Torque Alarm 
7 = Close Torque Alarm 
8 = Local Mode 
9 = Stop Mode 
10 = Remote Mode 
16 = Valve Drift Alarm 
17 = Power Monitor Alarm 
18 = Phase Monitor Alarm 
19 = Motor Thermal Alarm 
20 = Open Inhibit Alarm 
21 = Close Inhibit Alarm 
22 = Hardwired ESD Alarm 
23 = ESD Active Alarm 
24 = Lost Analog Input 1 Alarm 
25 = Lost Analog Input 2 Alarm  
26 = Host Control 
28 = Moving 
29 = Over Torque Alarm 
30 = Valve Stall Alarm 
31 = Low Battery Alarm 
32 = Monitor Alarms
33 = PST-(Partial Stroke Test) Pass
34 = Actuator Fail Alarm

0 = NC Continuous
1 = NC Flashing
2 = NO Continuous
3 = NO Flashing
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Table 41. TEC2 Relays 4 and 5

Relay Function Setting

4

0 = Limit Switch Open (LSO) 
1 = Limit Switch Close (LSC) 
2 = Limit Switch A (LSA) 
3 = Limit Switch B (LSB) 
4 = Opening 
5 = Closing 
6 = Open Torque Alarm 
7 = Close Torque Alarm 
8 = Local Mode 
9 = Stop Mode 
10 = Remote Mode 
16 = Valve Drift Alarm 
17 = Power Monitor Alarm 
18 = Phase Monitor Alarm 
19 = Motor Thermal Alarm 
20 = Open Inhibit Alarm 
21 = Close Inhibit Alarm 
22 = Hardwired ESD Alarm 
23 = ESD Active Alarm 
24 = Lost Analog Input 1 Alarm 
25 = Lost Analog Input 2 Alarm  
26 = Host Control 
28 = Moving 
29 = Over Torque Alarm 
30 = Valve Stall Alarm 
31 = Low Battery Alarm 
32 = Monitor Alarms
33 = PST (Partial Stroke Test) Fail
34 = Actuator Fail Alarm

0 = NC Continuous
1 = NC Flashing
2 = NO Continuous
3 = NO Flashing

5
26 = Generic (Host Control)
32 = Monitor Alarms
35 = Unit Alarm

 6 = Continuous 
 7 =  Flashing
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Table 42. EHO Relay 1

Relay Function Setting

1

0 = Limit Switch Open (LSO) 
1 = Limit Switch Close (LSC) 
2 = Limit Switch A (LSA) 
3 = Limit Switch B (LSB) 
4 = Opening 
5 = Closing 
8 = Local Mode 
9 = Stop Mode 
10 = Remote Mode 
16 = Valve Drift Alarm 
17 = Power Monitor Alarm 
18 = Phase Monitor Alarm 
19 = Motor Thermal Alarm 
22 = Hardwired ESD Alarm 
23 = ESD Active Alarm 
24 = Lost Analog Input 1 Alarm 
26 = Generic (Host Control) 
27 = Electronic Fault Alarm 
28 = Moving 
30 = Valve Stall Alarm 
34 = Actuator Fail Alarm
35 = Unit Alarm
36 = SOV Failure Alarm
37 = Hydraulic Circuit Failure Alarm
38 = Self-Calibration Failure Alarm
39 = Over Pressure Alarm
40 = Emergency Stop Alarm
41 = Host Command ESD Alarm

0 = NC Continuous
1 = NC Flashing
2 = NO Continuous
3 = NO Flashing

Table 43. EHO Relay 2

Relay Function Setting

2

0 = Limit Switch Open (LSO) 
1 = Limit Switch Close (LSC) 
2 = Limit Switch A (LSA) 
3 = Limit Switch B (LSB) 
4 = Opening 
5 = Closing 
8 = Local Mode 
9 = Stop Mode 
10 = Remote Mode 
16 = Valve Drift Alarm 
17 = Power Monitor Alarm 
18 = Phase Monitor Alarm 
19 = Motor Thermal Alarm 
22 = Hardwired ESD Alarm 
23 = ESD Active Alarm 
24 = Lost Analog Input 1 Alarm 
26 = Generic (Host Control) 
27 = Electronic Fault Alarm 
28 = Moving 
30 = Valve Stall Alarm 
34 = Actuator Fail Alarm
35 = Unit Alarm
36 = SOV Failure Alarm
37 = Hydraulic Circuit Failure Alarm
38 = Self-Calibration Failure Alarm
39 = Over Pressure Alarm
40 = Emergency Stop Alarm
41 = Host Command ESD Alarm

0 = NC Continuous
1 = NC Flashing
2 = NO Continuous
3 = NO Flashing
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Table 44. EHO Relay 3

Relay Function Setting

3

0 = Limit Switch Open (LSO) 
1 = Limit Switch Close (LSC) 
2 = Limit Switch A (LSA) 
3 = Limit Switch B (LSB) 
4 = Opening 
5 = Closing 
8 = Local Mode 
9 = Stop Mode 
10 = Remote Mode 
16 = Valve Drift Alarm 
17 = Power Monitor Alarm 
18 = Phase Monitor Alarm 
19 = Motor Thermal Alarm 
22 = Hardwired ESD Alarm 
23 = ESD Active Alarm 
24 = Lost Analog Input 1 Alarm 
26 = Generic (Host Control) 
27 = Electronic Fault Alarm 
28 = Moving 
30 = Valve Stall Alarm 
33 = PST- (Partial Stroke Test)
34 = Actuator Fail Alarm
35 = Unit Alarm
36 = SOV Failure Alarm
37 = Hydraulic Circuit Failure Alarm
38 = Self-Calibration Failure Alarm
39 = Over Pressure Alarm
40 = Emergency Stop Alarm
41 = Host Command ESD Alarm

0 = NC Continuous
1 = NC Flashing
2 = NO Continuous
3 = NO Flashing
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Table 45. EHO Relays 4 and 5

Relay Function Setting

4

0 = Limit Switch Open (LSO) 
1 = Limit Switch Close (LSC) 
2 = Limit Switch A (LSA) 
3 = Limit Switch B (LSB) 
4 = Opening 
5 = Closing 
8 = Local Mode 
9 = Stop Mode 
10 = Remote Mode 
16 = Valve Drift Alarm 
17 = Power Monitor Alarm 
18 = Phase Monitor Alarm 
19 = Motor Thermal Alarm 
22 = Hardwired ESD Alarm 
23 = ESD Active Alarm 
24 = Lost Analog Input 1 Alarm 
26 = Generic (Host Control) 
27 = Electronic Fault Alarm 
28 = Moving 
30 = Valve Stall Alarm 
33 = PST- (Partial Stroke Test)
34 = Actuator Fail Alarm
35 = Unit Alarm
36 = SOV Failure Alarm
37 = Hydraulic Circuit Failure Alarm
38 = Self-Calibration Failure Alarm
39 = Over Pressure Alarm
40 = Emergency Stop Alarm
41 = Host Command ESD Alarm

0 = NC Continuous
1 = NC Flashing
2 = NO Continuous
3 = NO Flashing

5
26 decimal = Generic (Host Control)
32 decimal = Monitor Alarms
35 decimal = Unit Alarm

6 = Continuous
7 = Flashing 
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Table 46. XTE3000 Relay 1 - Relay 7

Relay Function Contact Position

Relay 1 to Relay 7

0 = Open limit
1 = Close limit 
2 = Position >= %  
3 = Position <= %  
4 = Closing 
5 = Opening 
6 = Running 
7 = Blinker 
 8 = Mid-travel 
9 = Local Selected 
10 = Remote Select 
11 = Local STOP On 
12 = ESD/PST-efs  
13 = Man. Operation  
14 = Motor OverTemp  
15 = Over Torque 
16 = OP Over Torque
17 = CL Over Torque  
18 = Jammed in Open  
19 = Jammed IN Close  
20 = Valve Jammed
21 = Low Battery  
22 = Warnings 
23 = Mid Travel AL 
24 = EFS in manual 
25 = PST failed 
26 = MAINS-Only AS8  
27 = EFS Mid Travel 
28 = INTER/PST-icon  
29 = EFS Coil Off

Make 
Break

0 % to 100%

10.2.4.4 Analog 
The Analog tab shows the analog inputs and outputs possible for the actuator.

Figure 190 Analog Tab 
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10.2.4.5 ESD/Inhibits 
The ESD/Inhibits tab shows the various Emergency Shutdown (ESD) 
parameters, overrides, and inhibits.

Figure 191 ESD/Inhibits Tab

10.2.4.6 Speed 
The Speed tab shows the various speed control options available to the  
selected actuator.

Figure 192 Speed Tab
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10.2.4.7 Network 
The Network tab shows the network settings and configuration of the selected 
actuator. Some of the parameters here are set during the configuration of COM ports.

Figure 193 Network Tab  

NOTE:

If user changes network configuration, communication with the device may be lost.  
In case DCMlink is not communicating with the device, please close the Tag and use the  
communication setting that has been updated to that actuator.



February 2020
User's Guide 

DCM-402-0818 Rev. 2.3

150

Section 10: Detailed Setup

Detailed Setup

10.2.4.8 Input Characterization

NOTE:

This is only available in TEC2 actuators.

Figure 194 Input Characterization Tab 

 

Table 47. Input Characterization Type

Model TEC Family M2CP XTE3000 MPA HQDCM33 EHO

Input Characterization 
Type

Only applicable  
to TEC2:  
(4 options  
are available)  
0: Linear
1: Quick open
2: Equal percent
3: Custom 

N/A N/A N/A N/A N/A
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a. Linear 
The following curve shows a linear characteristic. The plot is ranged travel 
versus ranged input.

Figure 195 Linear Characteristic Curve

 – For linear type, characterization points are equal for Setpoint and target 
travel. The user can not change the data from target travel.  

 – The user can write these points to the actuator. 

 – The target travel points are as shown in below image.

b. Quick Open

Figure 196 Linear Characteristic Curve

 – For Quick open type, the user cannot change the data from target travel.  

 – The data points which are coming for Target travel section in dataset 
depend on the algorithm which is mentioned in attached spread sheet. 
The user can write these points in the actuator. 

 – DCMlink will load target travel points by itself when user selects Quick 
open type.
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c. Equal Percent

Figure 197 Equal Percent Curve

 

 – For Equal percent type, the user cannot change the data from  
target travel. 

 – The data points which are coming for target travel section in dataset 
depend on the algorithm which is mentioned in attached spread sheet 
above. The user can write these points in the actuator.

 – DCMlink will load target travel points by itself when the user selects 
Equal percent type.

 – The target travel points are shown in below image:

Figure 198 Target Travel Points
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d. Custom

 – The custom characteristic can be any number of curves. Therefore, no 
example characteristic is shown here. The process of entering values for 
a Custom Input Characterization is not obvious.

 – Default values for dataset will be based on the earlier target travel being 
loaded at DCMlink.

 – To change Travel Target* (Tvl Target) values, the user will need to 
change value at target travel section.  

 – Custom characterization read and write window is shown below: 

Figure 199 Input Characterization

Write Data to actuator Write Data to actuator
to user interface

10.2.4.9  Notes 

NOTE:

Refer to Section 10.2.4.8  for details.

 – Notes Tab will look like:

Figure 200 Notes Tab
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10.3 General Tab (Specific for HART)

• Right click on HART mode and select option as Detailed Setup.

Figure 201 Detailed Setup from HART Mode 

Click on “Detailed Setup”

• Click on General tab. 

Figure 202 General Tab Parameters 

General Tab Parameters:

• HART Tag: 8 character HART Tag.

• HART Long Tag: 32 Character HART Long Tag.

• Polling Address: Polling address range should be 0-63.

• Date: Date entered by user DD-MM-YYYY.

• Time: Time entered by user HH:MM:SS.

• Description: 32 character brief description of the device.
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Section 11: Valve Control

11.1 Introduction

DCMlink allows control of valve actuation through the Valve Control option. Users can use this  
function to open/close valves. 

• Valve control can also be used for initiating Host ESD or to clear ESD. 

• May also be used for initiating PST (the Relay shall be wired to the concerned DI at the 
STC/TBM).

• Analog Output can be controlled and Setpoint can be changed.

Figure 203 Accessing Valve Monitoring
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11.2 Configure Parameters

Valve control features three primary tabs used to control several parameters of a  
monitored actuator. Apart from controlling an active actuator, alarms and other inputs,  
as well as outputs, may be viewed and modified through the following tabs: 

• Valve Control

• Alarms

• Input/Outputs

11.2.1 Valve Control 

After clicking Valve Control, the following screen is displayed:

Figure 204 Parameter Configuration in Valve Control

 — Status Monitoring Window 
This will be similar to status shown in the status monitor screen.

 — Input Control

 – On/Off 

• Open: Clicking on this button will move the valve to  
open position. 

• Close: Clicking on this button will move the valve to  
close position.

• Stop: Clicking on this button will stop actuator movement.

NOTE:  

Actuator monitoring should be active and control mode should be set to network for the above 
functions to be usable.



User's Guide 
DCM-402-0818 Rev. 2.3 February 2020

157

Section 11: Valve Control

Valve Control

NOTE:

If the Set point tracking is not enabled in Detailed setup then the status below the Set point dial 
will show as degraded. It is recommended to enable Set point Tracking in Detailed setup.

 – Positioner (Modulating Mode) 
Setpoint sets the target position for the actuator to achieve. For 
example, if you set it at 10%, it will go to 10% Open (for MPA actuator; 
Setpoint corresponds to port number).

NOTE:  

Actuator monitoring should be active and control mode should be set to network for the  
Positioner function to be usable.

 — For more information please refer to Section 10.2 Configure Parameters.

 — ESD

 – Host ESD 
To Host ESD Command, two conditions must be met:

• Actuator Monitoring should be active.

• Host Command ESD should be enabled.

 – Clear ESD 
This will clear the ESD Alarm being raised in the actuator.

 — Input Control Window 
Shows Setpoint, Position, and Torque readings taken from the actuator.  
This information is similar to what is found in the status monitor screen.

 — Output Control Window

 – Analog Output: This function, based on the percenTage, sends anywhere 
from 4 mA to 20 mA to the Analog Output Pin. 0% -> 4 mA; 100% ->  
20 mA. To enable analog output, two conditions must be met:

• Actuator monitoring should be active.

• The source should be the host control.

 – Relay Control: Clicking on this will provide 24 V output to relay pins.  
To enable relay control, two conditions must be met:

• Actuator monitoring should be active.

• The source should be host control.
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11.2.2 Alarms may be accessed by clicking on the Alarms tab in valve control mode. 
Depending on the actuator model, alarms and their current status are shown in  
this screen:

Figure 205 Alarms

 

11.2.3 The Inputs/Outputs tab shows the status of all input/output settings. This tab is used 
to monitor and modify the various parameters available to the active actuator model.  

Figure 206 Inputs/Outputs
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Section 12: Diagnostics

12.1 Profile

12.1.1 Torque Profile

12.1.1.1 Torque Profile

12.1.1.2 Max Torque Profile 

12.1.1.3 Commanded Torque (PST/FST) Profile

12.1.2 Commanded Pressure (PST) Profile

Table 48. DCMlink Profile Comparison Table

Profile EHO TEC2 M2CP TEC2000 MPA HQ32 HQ33 XTE30002

Commanded Torque  
(PST) Profile

No Yes Yes No No No No Yes3

Commanded Pressure
(PST) Profile

Yes No No No No No No No

Commanded Torque  
(FST) Profile

No Yes Yes No No No No No

Max Torque Profile / HWM 
(101 points)

No Yes Yes No No No No No

Max Torque Profile / HWM 
(3 points)

No No No No No No No Yes

Torque Curve 
(1 Curve, 9 1/2 Points)

No No Yes1 Yes No No No No

Torque Curve 
(100 curves, 101 Points)

No No No No No No No Yes

Notes: 
1. Open direction only.
2. Available: Modbus, RS-232, Bluetooth (HART not available).
3. 16 curves. Datapoints plotted based on the travel limits. Modbus has only Diagnostic initiation  
      PST command.
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12.1.3 Torque Profile

Diagnostics to detect emerging valve repair requirements:

• Torque profile

• Archived torque profile

Torque Profile is currently available on:

• TEC2000 (open and close),  M2CP (open only), and XTE3000

Figure 207 Torque Profile

 

Functions available in Torque Profile View include:

• Upload Profile: Gives option to load the current torque profile in the actuator.

• Upload Archive Profile: Gives option to load the archive/saved torque profile in  
the actuator.

• Archive: Gives command to the actuator to archive the current profile  
into memory.

• Add Overlays: Gives option to plot the data from a previously saved dataset on top of 
the graph currently displayed

• Save Dataset: Gives option to save the database whenever user changes any 
parameter from the tab or when at least one profile is loaded or when user perform 
Upload profile.

• Delete Dataset: Gives option to delete a dataset.
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1. Graph Tab 
Shows the reported torque of the actuator. The blue lines show the closing torque 
profile and the red line shows the opening torque profile. 

Figure 208 Torque Profile View 

 

Functions available in the graph portion of torque profile view are:

• Plot Points: Shows plot points on graph.

• Grid Lines: Displays grid overlay on graph.

• Zoom In: Magnifies a particular portion on the graph and showing lines in greater detail.

• Zoom Out: Reduces magnification on graph.

• Zoom Back: Moves zoom magnitude to the original setting.

• Save Button: Saves graph to target directory.

• Print Button: Prints the graph.

• Full Screen: Maximizes view of the graph to full screen.

• Highlight Overlays: Allow user to cycle through the overlays displayed on graph.

Figure 209 Blue vs. Red Plot Lines in Open and Close Torque
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2. Data Points Tab  
Shows the actual values of actuator-reported torque.

Figure 210 Data Points Tab

3. Notes Tab  
Allows user to take notes on the available information.

NOTE:  

Open and Close torque profile is only available for TEC2000 and TEC2. Open torque profile and 
archive open torque profile are applicable only for M2CP. There is no torque profile for MPA,  
HQ, and EHO.

• Archive Torque Profile

 — An existing torque profile may be archived for later use by clicking on Archive 
while in Torque profile view.

Figure 211 Archive Torque Profile View

 

Archive Torque Pro�le
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12.1.3.1      Max Torque Profile ( Water Mark Torque Profile)

Max Torque Profile is currently available for TEC2 and M2CP Actuator.

Figure 212 Max Torque Profile

Functions available in Max Torque Profile View includes:

• Upload Max Torque Profile: Gives option to load the current Max torque profile in  
the actuator.

• Delete Profile: Gives option to clear current Open/Close Max torque profile in  
the actuator.

Figure 213 Delete Profile
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• Add Overlays: Gives option to plot the data from a previously saved dataset on top of 
the graph currently displayed

• Save Dataset: Gives option to save the database whenever user changes any 
parameter from the tab or when at least one profile is loaded or when user perform 
Upload profile.

• Delete Dataset: Gives option to delete a dataset.

1. Graph Tab 
Shows the reported torque of the actuator. The blue lines show the closing Max torque 
profile and the red line shows the opening Max torque profile. 

Figure 214 Max Torque Profile View 

Functions available in the graph portion of Max torque profile view are:

• Plot Points: Shows plot points on graph.

• Grid Lines: Displays grid overlay on graph.

• Zoom In: Magnifies a particular portion on the graph and showing lines in greater detail.

• Zoom Out: Reduces magnification on graph.

• Zoom Back: Moves zoom magnitude to the original setting.

• Save Button: Saves graph to target directory.

• Print Button: Prints the graph.

• Full Screen: Maximizes view of the graph to full screen.

• Highlight Overlays: Allow user to cycle through the overlays displayed on graph.
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Figure 215 Blue vs. Red Plot Lines in Open and Close Max Torque

 

2. Data Points Tab  
Shows the actual values of actuator-reported torque.

Figure 216 Data Points Tab 
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3. Notes Tab  
Allows user to take notes on the available information.

12.1.3.2 Commanded Torque (PST/FST) Profile  

For TEC2/M2CP: PST/FST is available via Command.

 — User need to select TEC2/M2CP Actuator Tag.

 — Right click Actuator Tag then click Torque Profile. The Dialog Box will appear.

 — In Configuration Tab, PST/FST profile options are available for all funtions like 
Start Diagnostics, Upload Profile, Upload Archive Profile, and Archive. 

Functions available in Commanded Torque PST/FST Profile View includes:

• Start Diagnostics: Gives option to Start the PST/FST profile.

• Upload Profile: Gives option to load the current torque profile in the actuator.

• Upload Archive Profile: Gives option to load the archive/saved torque profile in  
the actuator.

• Archive: Gives command to the actuator to archive the current profile  
into memory.

• Add Overlays: Gives option to plot the data from a previously saved dataset on top of 
the graph currently displayed.

• Save Dataset: Gives option to save the database whenever user changes any 
parameter from the tab or when at least one profile is loaded or when user perform 
Upload profile.

• Delete Dataset: Gives option to delete a dataset.

Commanded Torque (PST/FST) Profile has 4 Tabs:

1. Configuration Tab

2. Graph Tab

3. Data Points Tab

4. Notes Tab 
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1. Configuration Tab 
It includes PST/FST parameter groups and user should click Configure to edit  
needed parameters.

Figure 217 Configuration Tab For Commanded Torque (PST/FST) Profile

2. Graph Tab 
Shows the reported PST/FST of the actuator. The blue lines show the closing profile 
and the red line shows the opening profile.

Figure 218 PST /FST Profile View 

Functions available in the graph portion of PST/FST view are:

• Plot Points: Shows plot points on graph.

• Grid Lines: Displays grid overlay on graph.

• Zoom In: Magnifies a particular portion graph, showing lines in greater detail.

• Zoom Out: Reduces magnification on graph.

• Zoom Back: Moves zoom magnitude to the original setting.

• Save Button: Saves graph to target directory.

• Print Button: Prints graph reading.

• Full Screen: Maximizes the view graph to full screen.

• Highlight Overlays: Allow user to cycle through the overlays displayed on graph.
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Figure 219 Blue vs. Red Plot Lines in Open and Close PST/FST  

3. Data Points Tab  
Shows the actual values of actuator reported for PST/FST.

Figure 220 Data Points Tab

4. Notes Tab 
Allows user to take notes on the available information.

 
Running the Valve Signature Test include the below steps:

 — From Diagnostics menu, select Torque Profile. 

 — On the Configuration page, enter values in the PST and FST Start Position, 
End Position, travel limit and pause time text boxes, as necessary and click on 
the Start PST/FST.

 — PST/FST status shows the status of the test.

 — To save the new diagnostic data in the DCMlink Software database, click the 
Save Dataset. 

 — To review other saved diagnostic data, select a dataset. 

 — To run another new diagnostic test, select >new> in the Datasets list.

 — To view valve signature graph, click Graph tab. 
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12.1.4 Commanded Pressure (PST) Profile 

This is applicable for EHO actuator only. For other actuators this option is disabled. Diagnostics 
to detect emerging valve repair requirements are:

 — To access the Pressure Profile, right click Actuator Tag context 
menu>Profile> Pressure Profile.

 — On the Configuration page click Start Diagnostics.

 — Click on Start PST.

Functions available in Pressure Profile View includes:

• Start Diagnostics: Gives option to start PST profile.

• Upload Profile: Gives option to load current PST profile in the actuator.

• Add Overlays: Gives option to plot data from a previously saved dataset on top of the 
graph currently displayed.

• Save Dataset: Gives option to save the database whenever user changes any 
parameter from the tab or when at least one profile is loaded or when user perform 
upload profile.

• Delete Dataset: Gives option to delete a dataset.

Pressure Profile has 4 Tabs:

1. Configuration Tab

2. Graph Tab

3. Data Points Tab

4. Notes Tab

1. Configuration Tab 
Includes PST parameter group, and then user clicks Configure to add  
necessary parameters.

Figure 221 Configuration Tab 
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Figure 222 PST Parameters  

2. Graph Tab 
Shows the reported Pressure of the actuator. The blue lines show the closing Pressure 
profile and the red line shows the opening Pressure profile.

Figure 223 Pressure Profile View

 

Functions available in the graph portion of Pressure profile view are:

• Plot Points: Shows plot points on graph.

• Grid Lines: Displays grid overlay on graph.

• Zoom In: Magnifies particular portion on graph, showing lines in greater detail.

• Zoom Out: Reduces magnification on graph.

• Zoom Back: Moves zoom magnitude to the original setting.

• Save Button: Saves graph to the target directory.

• Print Button: Prints graph reading.

• Full Screen: Maximizes view of graph to full screen.

• Highlight Overlays: Allows user to cycle through the overlays displayed on graph.
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Figure 224 Blue vs. Red Plot Lines in Open and Close Pressure

3. Data Points Tab 
Shows the actual values of actuator reported pressure.

Figure 225 Data Points Tab 

4. Notes Tab 
Allows user to take notes on the available information.

Running the Valve Signature Test for Pressure Profile requires the below steps:

• From the Diagnostics menu select Pressure Profile. 

• On the Configuration page, enter values in the PST, for Start Position, End Position, 
travel limit and pause time text boxes, as necessary and click Start Diagnostics to 
Start PST option.

• PST status will show the status of the test.

• To save the new diagnostic data in the DCMlink Software database, click Save Dataset. 

• To review other saved diagnostic data, select a dataset. 

• To run another new diagnostic test, select >new> in the dataset list.

• To view valve signature graph, click Graph tab.  
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5. Add Overlay

Figure 226 Add Overlay 

A

B

C D

E F G H I

J

K

Note: 

The DCMlink permits a maximum of 10 graph overlays.

a. Tag: In tag text box user can enter the tag name of device and then click Enter 
to search. 

b. Tags Found: Displays all the tags which are saved in database.

c. Dataset: Dataset dropdown allows user to select the previously saved dataset. 
It contains the dataset name and profile name in bracket ( ). 

d. Select: The selected dataset name will be displayed in the overlay datasets 
selected box.

e. Remove: Removes the selected dataset. 

f. Remove All: Removes all datasets added in Overlay Datasets Selected section.

g. View Overlay: Shows the selected dataset graph on graph window.

h. Close: Overlay dialog box gets closed, without applying any settings.
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12.2 Modbus Traffic Viewer

12.2.1 This application provides option to launch Live Communication Viewer window using 
the right-click context menu from the Device Tag.

Figure 227 Accessing Device Configuration Viewer 

 

12.2.2 Live Communication Viewer must log every request as RX in Red: 
RX <Date Time> <Communication Data coming from actuator> 

12.2.3 Live Communication Viewer must log every response as TX in Blue: 
TX <Date Time> <Communication Data sent to actuator> 

Figure 228 Live Communication Viewer in Modbus Master
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Figure 229 Live Communication Viewer in RDM

 

Figure 230 Live Communication Viewer in TCP
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Figure 231 Live Communication Viewer in Bluetooth

 

12.2.4 Also Live Communication Viewer window provides the below options:

 — No Log: To stop logging traffic to window.

 — Log Traffic to Window: To start logging traffic to window.

 — Log Traffic to File: To export logged traffic to external file. 

 — Clear Window: To clear logged traffic in window.

 — Log in Decimal: To show traffic communication data in Decimal.

 — Log in Hexadecimal: To show traffic communication data in Hexadecimal.

 — Close: To close Live Communication Viewer window.

 — Help: To launch help related to Live Communication Viewer window.
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12.3 XTE3000 RS-232 Communication Viewer

Figure 232 

12.4 HART Communication Viewer

12.4.1 This application provides option to launch Live Communication Viewer window using 
the right-click context menu from the Device Tag.

Figure 233 Accessing Device Configuration Viewer  

12.4.2 Live Communication Viewer must log every request as RX in Red: 
RX <Date Time> <Communication Data coming from actuator> 

12.4.3 Live Communication Viewer must log every response as TX in Blue: 
TX <Date Time> <Communication Data sent to actuator > 
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Figure 234 Live Communication Viewer HART

 

12.4.4 Live Communication Viewer window provides the belwo options:

 — No Log: To stop logging traffic to window.

 — Log Traffic to Window: To start logging traffic to window.

 — Log Traffic to File: To export logged traffic to external file. 

 — Clear Window: To clear logged traffic in window.

 — Log in Decimal: To show traffic communication data in Decimal. 

 — Log in Hexadecimal: To show traffic communication data in Hexadecimal.

 — Close: To close Live Communication Viewer window.

 — Help: To launch help related to Live Communication Viewer window.
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12.5 Event Log

NOTE:  

Event logging is available only for the TEC2 and M2CP.

Figure 235 Event Log Viewer

 

Figure 236 Event Log Viewer Window
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 — Export: Exports the entire event log in .csv format.

 — Filter: Allows the option to display information based on the selected event 
type only.

Figure 237 Event Log Filter 

 — Read: Reloads the entire event log.

 — Close: Closes the Event Log window.

 — Help: Opens the help dialog box.

12.6 Data Logger

Data Logger is available only for the XTE3000 over Bluetooth and RS-232 protocol.

Figure 238 Data Logger Viewer

Text
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In XTE3000 there are four modes of Data Logger:

• Event 

• Recorder 

• T-Recorder 

• OFF

All Data Logger Information could be configured using the “configure” button. It navigates to 
the "Detailed Setup" screen where under "Data Logger" tab user can set configuration.

On clicking the ‘Upload’ button, it will upload all the tabs for the selected Data Logger Mode.

Figure 239 Data Logger with Logger Mode as “Event”

Figure 240 Data Logger with Logger Mode as “Recorder”
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Figure 241 Data Logger with Logger Mode as “T-Recorder”

12.7 Connection Logger

Connection Logger is available only for the XTE3000 over Bluetooth and RS-232 protocol. 
Connection Logger screen is launched from Menu Tools -> Connection Logs Viewer.

Figure 242 Connection Logger Viewer

Connection Logger screen keeps the record of all the connections made with the actuator.   
Its shows information PWD, Device Id, Operator Name, Connection type, Date, and time  
of connection.
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12.8 Card Report

Card Report is available only for the XTE3000 over Bluetooth and RS-232 protocol.  
Card Report screen is launched from Menu Tools -> Card Report.

Figure 243 Card report View

• Refresh: Reloads all Parameters values. 

• Write: Write all the changed parameters to actuator.
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12.9 FDI Controls

FDI Controls is available only for the XTE3000 over Bluetooth and RS-232 protocol.  
FDI Controls screen is launched from Menu Tools -> FDI Controls.

Figure 244 FDI Controls Views

NOTE:

FDI Controls Details are based on the Hardware Configuration.
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12.10 Bus Information

Bus Information is available only for the XTE3000 over Bluetooth and RS-232 protocol.  
Bus Information screen is launched from Menu Tools -> Bus Information.

Figure 245 Bus Information Views

NOTE:

Bus Information Details are based on the Hardware Configuration.
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12.11 Encoder Information

FDI Controls is available only for the XTE3000 over Bluetooth and RS-232 protocol.  
FDI Controls screen is launched from Menu Tools -> Encoder Information.

Figure 246 Encoder Information Views
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Section 13: Calibration Procedure

13.1 Introduction

DCMlink provides a step-by-step procedure for end user to perform Analog Input and  
Output calibration.

Calibration allows the user to calibrate using various calibration tools. It also provides the 
following functions and advantages:

• Enhance productivity with easy-to-use calibration tools.

• Support for Analog Input and Output Calibration.

• Calibration available for TEC2/M2CP/HQ/EHO.

• Home Port Calibration is only available for the MPA. 

NOTE:  

Calibration may be executed only when monitoring is inactive. Perform calibration preferably 
before device monitoring is activated.  
Calibration settings and menus vary per actuator. For example, an M2CP will have different  
calibration procedures than a TEC2. Check actuator manual for calibration settings.  

13.1.1 On the menu bar, click Calibration.

Figure 247 Calibration from the Menu Bar

 

Calibration

13.1.2 Alternatively, Calibration may be accessed by right-clicking on the actuator Tag 
in the navigation pane and clicking on Calibration. The user may also click on the 
Calibration icons in the tool bar.



User's Guide 
DCM-402-0818 Rev. 2.3 February 2020

187

Section 13: Calibration Procedure

Calibration Procedure

13.2 Analog Input & Output Actuator  
Connection Details

Below are the calibration options available from DCMlink.

Table 49. 

Actuator Analog Input 1 Analog Input 2 Analog Output 1 Analog Output 2 Analog Torque Pot Input

M2CP
P4 Connector=> 
Pin#1 (+ve)
Pin#2 (-ve)

P4 Connector=> 
Pin#3 (+ve)
Pin#4 (-ve)

P4 Connector=> 
Step 1. Pin#5 (apply 
24V DC)
Step 2. 0V connects 
to – of loop calibrator
Step 3. + of loop 
calibrator connects 
to Pin#6

NA
Connect a 5K or 10K 
potentiometer to 
connector P3

TEC2
25+ve
26-ve

27+ve
28-ve

31+ve
32-ve

33+ve
34-ve

NA

MPA NA NA NA NA NA

HQ32 NA NA NA NA NA

HQ33 NA NA NA NA NA

TEC2000 NA NA NA NA NA

EHO
25+ve
26-ve

NA
27+ve
28-ve

29+ve
30-ve

NA

XTE3000 NA NA NA NA NA

13.2.1 Apply Current source to Pins of each Actuator as shown below:

Figure 248 M2CP Actuator Analog Input, Output, Ground Connections
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Figure 249 TEC2 Actuator Analog Input, Output, Ground Connections

Figure 250 TEC2 Input, Output, Ground Pin Details
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Figure 251 EHO Actuator Analog Input, Output, Ground Connections

 

Figure 252 EHO Input, Output, Ground Pin Details
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13.3 Analog Input Calibration

Figure 253 Calibration from the Navigation pane 

 

Calibration

13.3.1 After clicking Calibration, click Accept.

Figure 254 Analog Input 1 or 2 Calibration

 

13.3.2 After calibration completes, click OK.

Figure 255 Calibrating to 4 mA Reference
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13.3.3 Another calibration option (20 mA). Click Accept.

Figure 256 Calibrating to 20 mA reference

 

13.3.4 Calibration is completed after clicking Accept.

Figure 257 Analog Input 1 Calibration Completed

 

13.4 Analog Output Calibration

13.4.1 Executing Output Calibration using the applicable actuators begins by clicking Analog 
Output Calibration.

Figure 258 Analog Output Calibration 1 or 2 

Output Calibration
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13.4.2 Click Yes.

Figure 259 Start Analog Output Calibration

 Start Output Calibration

13.4.3 Ensure correct wire configuration and click Accept.

Figure 260 Start Analog Output Calibration

 

Perform Wire Configuration 
and click Accept
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13.4.4 Click Up and Down arrows until the value adjusted for is acceptable. Once complete, 
click Accept. This concludes the 4 mA output calibration.

Figure 261 Start 4 mA Analog Output Calibration

 

Click Accept once the value 
adjusted for is acceptable

13.4.5 For the 20 mA output calibration, similar steps apply. Click Up and Down arrows until 
the values are acceptable. Once complete, click Accept. 

Figure 262 Start 20 mA Analog Output Calibration

 
Click Accept once the value 
adjusted for is acceptable

13.4.6 Once output calibration completes, a window will appear stating this. Click OK.
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13.5 MPA Home Port Calibration

13.5.1 MPA Home Port Calibration window is used to align the electronic position with the 
physical ports of the MPA.

Figure 263 Accessing MPA Home Port Calibration

 

Figure 264 MPA Home Port Calibration
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13.6 EHO Self-Calibration

13.6.1 Self calibration can be performed on the EHO Smart electric actuators. After loading 
an EHO Tag, calibration can be accessed by using the menu bar, the tool bar, or  
right-clicking on the Tag. In this example, the menu bar Calibration is clicked, followed 
by Self-Calibration. 

Figure 265 EHO Self-Calibration (1)

 

Self Calibration

13.6.2 A dialog box will appear and ask for calibration to proceed. Click Yes.

13.6.3 Input the desired values and click Start.

13.6.4 Self-Calibration concludes once the inputted values are accepted. Click OK on the 
dialog box that appears at the conclusion.

Figure 266 Input values for Self-Calibration 
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To download Firmware from DCMlink: 
Select Tools Menu and click on Firmware Download option.

Figure 267 Firmware Download Menu 

• Click Firmware Download option, Dialog Box will appear.

Figure 268 Firmware Download Dialog 
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• Click on Firmware File Option & click on the Browse to select the file.

Figure 269 Firmware Download Selection Dialog 

• Once all Firmware files are selected click on Download. 

Figure 270 Firmware Download 
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• Firmware Download is in Progress & user can click on Abort if Download is  
not required.

Figure 271 Firmware Download In Progress 

 

14.1 Firmware Download XTE3000

To download Firmware from DCMlink; select Tools Menu and click on Firmware Download option.

Figure 272 Firmware Download Menu
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• Click Firmware Download option, Dialog Box will appear.

Figure 273 Firmware Download Dialog

• As it could be seen that Firmware download screen is divided into four groups.

1. Current Version: By clicking on the Read Button, current Firmware information would  
get populated.

Figure 274 

2. Browse Firmware File(s): One by one we select the Program and the Operation need 
to perform and then browse file location. There are Five Programs – Kernel, Erase, Update, 
Firmware, and Language. For each program there are two Operations (except language has 
write operation only). Then Click on Add button to browse file path.

Figure 275 
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3. Other Operation: After Browsing all Firmware File, two other operation can be performed.  
               a. Check Firmware and b. Transfer 

Figure 276 

4. Click: Check 'Firmware' to verify the data are correct. Click 'Transfer' to initiate transferring 
the new firmware from actuator flash memory to the actuator program memory. When the 
operation ends it needs to repower the actuator.

Figure 277 
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5. Status: On clicking start button, it will start performing all the operation listed above and 
status of all can be seen one after another.

Figure 278 

Figure 279 Firmware Download in Progress
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Scheduler is a feature that allows user to run various types of tests at predefined intervals 
without user intervention. The resulting data is available for later viewing and analysis.

• The Scheduler gives the capability to specify a time and date to automatically run a 
task on a actuator. 

• An unlimited number of tasks can be set up in the Scheduler for a one-time use, daily, 
weekly, monthly, or yearly occurrence.  

• A history of all tasks completed is maintained in the History page of the Scheduler, 
indicating the problem found, the reason for the problem, and a solution to resolve  
the problem.  

• Scheduler functionality is not available from DCMlink SNAP-ON™ for DeltaV™,  
and it is only available on DCMlink Software (Solo) installations.  

• DCMlink S/W allows the user to enable/disable the scheduler. 

• Scheduler information (tag and task data) will be persisted in the database  
(on a local PC).

• If the Scheduler has initiated a task on an actuator then the corresponding device icon 
in the tree view is modified to show a stopwatch superimposed on the original icon. 
Also, the progress will appear in the Taskbar window.

Figure 280 

Scheduler:
Tools -> Scheduler

 — Scheduler menu item is disabled when polling is on for Status Monitor/Valve 
Control screen.
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Figure 281 

Scheduler Tool Bar

 — All error conditions are gracefully handled by Scheduler and noted in the 
Status column for that task. For example, if the device is disconnected, the 
Scheduler would display retry under the Status column. 

 — If the retry limits exceed, then show the reason for failure in the Status column. 

15.1 Scheduling A New Task

15.1.1 Current Tab

• Scheduler window includes the current tab for showing the list of Scheduled Task. 

• This page must contain the current schedule configuration, including tasks that are 
currently running and ones that are scheduled for the future.  

• Current tab data grid shows following columns:

 — Tag: Selected Tag. 

 — Task Type: Selected task type for scheduler. 

 — Description: Task’s description.  

 — Parameters: Parameters required for the task. 

 — Status: Current Status of the task. 

 — Frequency: Frequency of the task to be executed. 

 — Next Time: Display next time on which task shall be executed. 
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Figure 282 Scheduler Current Tab view

15.1.2 History Tab

• Scheduler window includes the History tab for logging and tracking the status of 
Scheduler and Scheduled Task. 

• A history of all tasks completed is maintained in the History page of the Scheduler, 
indicating the problem found, the reason for the problem, and a solution to resolve  
the problem. 

• History tab must show following columns:  

 — Tag: Tag name.  

 — Task Type: Selected task type.  

 — Description: Description about the task.  

 — Status: Shows the status of the task.  

 — Timestamp: Date and Time when this entry is logged.

Figure 283 
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15.1.3 Add New Task

When user clicks on Add Task button then display below dialog to user for adding task into 
scheduler. The dialog is loaded with below fields and values as shown in below snap.

Figure 284 

• User can also fetch tag information, after selecting the tags from the list and clicking 
on tag Info button.

Figure 285 

NOTE:

Scheduler allows unlimited number of tasks to be set up in the Scheduler for a one-time use, 
daily, weekly, monthly, or yearly occurrence.
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15.1.4 Scheduler Task Types

• There is different scheduler task available for different actuators on the basis of protocols.  

• Below table states the task list.

Table 50. 

Actuator Protocol Tasks

TEC2

Modbus Extract Device Info, Max Torque, PST, FST

HART Extract Device Info, Max Torque, PST, FST

Bluetooth Extract Device Info, Max Torque, PST, FST

XTE3000

Modbus Extract Device Info, PST

HART Extract Device Info, PST

XTE RS-232 Extract Device Info, PST

Bluetooth Extract Device Info, PST

TEC 2000
Modbus Extract Device Info

HART Extract Device Info

EHO
Modbus Extract Device Info, PST

HART Extract Device Info, PST

M2CP (FW 361)
Modbus Extract Device Info, Max Torque, PST, FST

HART Extract Device Info, Max Torque, PST, FST

M2CP
Modbus Extract Device Info

HART Extract Device Info

MPA Modbus Extract Device Info

NOTE:

DCMlink would initiate PST, FST command, but it would not save the profile information in  
the dataset.
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• Extract Device Info can be launch through context Menu of the selected tag.

Figure 286 Extract Device Info Launch

• Whenever user clicks on the “Extract Device Info” Button, it will export all the available 
actuator data in .dfx file (TEC2, M2CP, EHO). 

• Only for XTE3000 over Bluetooth and RS-232 protocol it exports all the available 
actuator data in .xte file. 

• Only for XTE3000 over HART protocol it exports all the available actuator data in  
.hart file.

Figure 287 Extract Device Info View

• Default path of the open file dialog will be C:\Users\ [user name]\Desktop Default 
File Name will be [TagName]_ExtractConfig_[ActuatorName]_[CurrentDate]__
[CurrentTime] 

NOTE:

Extract Device Info Operation can also be performed through scheduler.
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17.1 Write Protect 

Write protection is the ability to prevent new configuration from being written or old 
information being changed. This means you can read the data, but not write. 
To Enable Write Protect from DCMlink select Actuator Setup Menu and click HART.

Figure 288 Write Protect Menu

 

• Click Write Protect option, Dialog Box will appear.

Figure 289 Write Protect Dialog Box

 

NOTE: 

Write Protect can be Enabled from DCMlink. Once it is Enabled, it can be disabled only through 
LDM on the actuator. For Disabling the Write Protect please refer to the Actuator Manual.
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17.2 Device HART Mode Dialog (AUTO/MANUAL)

To change the current HART protocol Mode use below steps:

• From HART Tag context menu click Protocol Mode.

Figure 290 Protocol Mode From Context Menu 

 

• Below Dialog box will appear, which will allow making the device In service and  
Out of service mode. 

Figure 291 Device HART Mode Dialog
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• To Set Out of Service: 

Figure 292 Set Out of Service (MANUAL) Dialog 

• To Set In Service Mode:

Figure 293 In Service Mode (AUTO) Dialog 
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17.3 Rebuild HART Network 
 
There are 2 Rebuild  options:

 — HART Modem 

 — HART MUX rebuild

• From Network Menu click Rebuild Option.

Figure 294 Rebuild Option 

• For HART Modem Rebuild below Windows will appear.

Figure 295 HART Modem Rebuild Menu
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Figure 296 HART Modem Rebuild Dialog 

      

• For HART MUX Rebuild below Windows will appear.

Figure 297 HART MUX Rebuild
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Figure 298 HART MUX Rebuild 
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Database is a collection of data stored systematically to allow rapid searches, sorts, and simple 
retrieval. DCMlink database stores data about Tags and associated devices. A Tag's database 
record might include multiple datasets from actuator specifications, configuration parameters 
and diagnostic test results. 

18.1 Database for Diagnostic Storage

18.1.1 Database for SOLO

18.1.1.1 SQL CE

 — By default DCMlink uses the SQL CE 4.0 or later database.

18.1.1.2 SQL Server

 — Installation of the SQL server need to be done by the customer.

18.1.1.3 Switch Between SQL CE and SQL Server

 — User can switch between SQL CE and SQL server from DCMlink. DCMlink 
will copy the data content from SQL CE database to the SQL Server database 
whenever user want to switch.

Figure 299 Switch Between SQL CE and SQL Server
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• Switch to SQL Server

 — Once the tables are created in the main SQL server, the DCMlink remembers 
the SQL server details and begin storing the data to the new database.

Figure 300 Switch to SQL Server

 

NOTE:

User must have a licensed version of SQL server. DCMlink will not distribute the SQL  
server license.

• Switch to SQL CE

 — Once the tables are created in the SQL CE, the DCMlink remembers the SQL CE 
connection details and begin storing the data to the new database.

   

Figure 301 Switch to SQL CE

  

18.1.2 Database for AMS SNAP-ON 

 — The DCMlink SNAP-ON will use the SQL-CE 4.0 or later. 
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18.2 Tag Management for SOLO and SNAP-ON

For SOLO and DTM, the user can add, delete or modify existing Tags.

NOTE:

Database makes entry while user opens (launches: Status Monitor, Detailed Setup, etc.) any Tag 
for the first time.

The offline Tags are already stored in the local SQL-CE DB of DCMlink. They are available even if 
the corresponding DTM device is not available.

If the database Tag is referenced to a live Tag, user can perform operation like a live Tag. 

If there is no live reference Tag available, any operation that needs communication with 
actuator is  restricted (like: Start Monitoring on Status Monitor, Saving settings to actuator 
on Detailed Setup). These buttons (write/action) are disabled. When the actuator column is 
empty, means no data is showing in the device.  Under scheduler user can schedule any task for 
DB Tag, but it will fail during  execution, as DCMlink will not find live matching Tag connected.

• When user opens Tag (launches: Status Monitor, Detailed Setup, etc.) then DCMlink 
updates Tag icon in both live Tag and corresponding matching DB Tag with Magnifying 
icon overlapped to Tag icon. 

Figure 302 Magnifying Symbol

 

18.2.1 HART Tag Management

There are more options for Offline Tags: 

1. New HART Tag

2. Modify HART Tag

3. Delete HART Tag
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1. New HART Tag

Creating a Tag establishes a new database record in the DCMlink database to store information 
about the actuator.

 — The New HART Tag option is available in Tag New Tag menu.

 — New Tag Dialog Box will appear, enter information about the actuator in  
the HART Tag Window tabs:  Valve, Groups, HART Mux, and Notes in the New 
Tag window. 

 — When you finish entering information, click Save Tag.

Figure 303 New HART Tag

• When user clicks on HART Tag option below options appear.

 — HART Tag Window contains below four groups:

a. Valve

b. Groups

c. HART Mux

d. Notes

Figure 304 HART Tag Window-Valve 
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a. Valve

• HART Tag: 

 — The HART Tag should be up to 8 characters.

 — It is any combination of up to 32 letters, numbers, and characters as a Tag.  
The Tag can be saved in the DCMlink database when user clicks Save Tag.

 — While creating a HART Tag manually, DCMlink checks if there is any old Tag 
present in the database with the same Tag value (not the HART Tag). If there is 
no matching Tag found, then DCMlink  creates a new Tag entry in the database. 
But if DCMlink finds a matching Tag, it displays a message box to the user.

 — This Means multiple Tags can be present in the database, with same HART 
Tag. But multiple Tags with same Tag name can’t be present. Also, with the 
same HART Tag value, there could be multiple Tags present (having different 
Tag value).

• Actuator Model:

 — TEC2000, TEC2, M2CP, MPA, HQDCM33, EHO, XTE3000.

• Actuator Type: 

 — Quarter-turn or Multi-turn (NA for XTE3000).

• Actuator SN: 

 — Actuator serial number.

• Use Custom image of the actuator: 

 — In case customer wants to see any other image that DCMlink shows by default 
for an actuator. This image information gets stored in the database for that 
particular Tag.

• Descriptor:

 — User can enter the 16 characters description of the device.
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b. Groups

Figure 305 HART Tag Window-Groups

• Group label: 

 — The labels are the Groups created or available. The default group names are 
Group 1 to Group 4.

• Drop down list: 

 — The drop down list displays the Sub Groups that are available in the  
main group.

c. HART MUX

Figure 306 HART Tag Window-HART MUX

• Mux Address: 

 — DCMlink allows the user to enter the multiplexer address to which the 
instrument is attached. Values range from 0 to 31.

• Node: 

 — Information in this field applies to the MTL multiplexers only. DCMlink allows 
user to enter the node number for the MTL4842 HART interface module to 
which the instrument is attached in a MTL4840 Maintenance system; values 
range from 1 to 16.
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NOTE: 

If the instrument is not connected in an MTL system, DCMlink allows to enter 0 in the Node field.

• Loop Number: 

 — The loop number is for the actuator. its Value ranges from 0 to 255.

NOTE: 

Mux address, Node and loop number should not be empty. If fields are empty then display  
message box to user as following.

• DCS Loop ID: 

 — Enter the DCS (Distributed Control System) point Tag, or other identifying 
information, for the loop associated with the actuator. The DCS is the controlling 
system that sends a 4-20 mA analog signal to the actuator.

d. Notes tab: 

 — Notes field is used for entering descriptive information of the HART Tag.  
This note gets saved with current system date/time as dataset in the database. 
DCMlink allows modifying this note, without creating a new dataset.  
Means the new note text gets updated against the dataset ID.

2. Modify HART Tag

 — Right Click on HART Tag and click Modify Tag option

 — Modify Database Tag Dialog Box will appear, enter information about the 
Actuator in the Modify Tag Window tabs:  Valve, Groups, HART Mux, and Notes 
(for HART Tag Window Tabs detail information refer to section New HART Tag).

 — When you finish entering information, click Save Tag button.

Figure 307 Modify HART Tag 
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Figure 308 Modify HART Tag Dialog Box 

3. Delete HART Tag

When user wants to delete a tag, it also deletes all DCMlink Software database records 
associated with that tag. 

NOTE:

User cannot delete an open tag. Tag  must be in Closed condition.

 — Right Click on HART Tag and click Delete Tag option.

 — An alert Dialog box will appear to confirm the Tag Delete operation. At the 
confirmation message, click Yes to delete the selected tag and its associated 
DCMlink software database records. Click No to close the confirmation 
message window and return to the Tag Management window. 

Figure 309 Delete HART Tag
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18.2.2 Modbus Tag Management 
 
Creating a tag establishes a new database record in the DCMlink database to store 
information about the Actuator.

 — The New Modbus Tag option is available in Tag New Tag menu.

 — New Tag Dialog Box will appear, enter information about the Actuator in the 
New Tag Window tabs:  Valve, Groups and Notes (for New Tag Window tab 
detail information refer to section New HART Tag).

 — When you finish entering information, click Save Tag. 

Figure 310 Modbus Tag Management 
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18.3 XTE RS-232 Tag Management

 — The New XTE RS-232 Tag option is available in New Tag menu. 

 — New Tag Dialog Box will appear, enter information(s) about the Actuator in 
the New Tag Window tabs: Valve, Groups and Notes (for New Tag Window tab 
detail information refers section New HART Tag).

 — When you finish entering information, click Save Tag.

Figure 311 XTE RS-232 Tag Management

NOTE:

XTE RS-232 Tag could only be created for XTE3000 actuator.
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18.4 Database Operation (SOLO on SQL CE)

Database has 3 options available.

1. Compact Database

2. Repair Database

3. Switch Between SQL CE and SQL Server

Figure 312 Database Options

1. Compact Database 

 — It helps to reclaim wasted space in database by creating a new database file 
from the existing file.

2. Repair Database

 — This option is used to repair a corrupted database.

 – First try to recover the corrupted rows.

 – Then remove the remaining corrupted rows (If repair does not work.)

3. Switch Between SQL CE and SQL Server

 — For details refer to Section 18.1.1.3.
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18.5 Dataset

A Dataset is a grouping of actuator information that can be saved as a date and time stamped 
record in the database. Datasets are historical records of the particular condition and state of 
the actuator the time the dataset was saved. The values saved in a dataset are for the user’s 
reference only.

Dataset may be saved in many different DCMlink functions:

• Detailed Setup

• Status Monitor

• Factory Settings

• PST/FST (Profile)

Figure 313 Dataset



February 2020
User's Guide 

DCM-402-0818 Rev. 2.3

226

Section 18: Database

Database

18.5.1 New Dataset 

It is used to save new entry in the database or if user makes any changes to the Saved Dataset 
and save with New Dataset. It is available while opening any Tag function listed below:

• Detailed Setup

• Status Monitor

• Factory Settings

• Profile 

Figure 314 New Dataset

18.5.2 Select Saved Dataset

 — DCMlink allows user to select from any Saved Dataset. Click on the dataset 
item that needs to be retrieved and wait till the dataset values get loaded.

Figure 315 Select Saved Dataset
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18.5.3 Changing Dataset Dropdown Item  
 
Changing Dataset

 — DCMlink prompts user in case of changing the drop down option from Saved 
dataset to New.

Figure 316 Changing Dataset

 — If user makes any changes in the dataset side, below message will appear while 
changing the Dataset drop down option from the top.

Figure 317 Changing Dataset Dialog Box
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18.5.4 Notes Tab 

 — Notes field is used for entering descriptive information on the alert conditions 
and monitor values. 

Figure 318 Notes Tab

18.5.5 Save Dataset

This is used to save new dataset or if user makes any changes to the Saved Dataset. 

Figure 319 Save Dataset

NOTE: 

While monitoring is going on (polling is going on) Save Dataset will remain disabled. If user 
stops monitoring (means stops polling) the Save Dataset will be enabled.
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18.5.6 Delete Dataset 

• When user deletes a tag, it also deletes all database records associated with that tag. 

• When user clicks on Delete Dataset, the Dataset name gets deleted from the 
dropdown combo box. DCMlink allows deleting saved dataset. 

Figure 320 Delete Dataset

18.5.7 Reset Dataset 

 — Reset Dataset option is not applicable for Status Monitor. It is only applicable 
for Detailed Setup,  Factory Settings and Profile. This option resets the 
Dataset column values for all the parameters to their default values.

Figure 321 Reset Dataset
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18.5.8 Copy From Tag 

 — Copy From Tag Option is not applicable for Status Monitor. 

Figure 322 Copy From Tag

 

 — Once user clicks on this option below Dialog box appears. 

 — DCMlink shows all the saved dataset available against the particular Tag;  
so that user can select any one among the saved datasets.

NOTE:

Only Includes Tags with the same actuator types.

Figure 323 Copy Configuration From Tag
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18.5.9 Download/Upload Entire Configuration

 — This function is available in actuator Detail Setup menu.

There are the 2 options available to write parameters to the actuator.

• Download To Actuator 

 — User can make changes to the parameters in DCMlink and write those 
parameters to the actuator. When user clicks on save all changes arrow button 
for Page/Entire configuration as shown below, then DCMlink shows a message 
box which contains accumulated text of all the individual parameters with Yes 
and No button. This option is disabled until DCMlink Software is connected to 
the actuator.

• Actuator To Dataset

 — User can make changes to the dataset value of parameters and write those 
parameters to the DCMlink database. When user clicks on save all changes 
arrow button for Page/Entire configuration as shown below. This option is 
disabled until DCMlink Software is connected to the actuator.

Figure 324 Download To Actuator and Actuator To Dataset

Download to
Actuator

Actuator to
Dataset

 

Figure 325 Message Box for Parameter Changes
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18.5.10    Import/Export Tag

DCMlink provides an option to Import and Export Tag data in file format.

Figure 326 Import/Export Tag

• Import Tag Data

Copy a file containing tag information and datasets into the DCMlink  Software database. 

 — From Tag menu click on Import Tag Data.

 — User can select a file to import and click Open.

 — Import tag option shall be enabled and executed when live device tag is closed.

NOTE: 

When an import is selected it will bring in all information that was exported.  
One exported Tag file can have details of multiple Tags.

Figure 327 Import Tag Data
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 — After importing Tag, DCMlink copies the database records contained in the file 
into the DCMlink Software database. 

 — If a Tag has the same name as an existing Tag, DCMlink Software notify user 
with a message and provides options for handling the duplicate Tag.

Figure 328 Tag Already Exists

 

• Skip

 — DCMlink do not import the Tag into the database. The existing Tag and its 
dataset remains unchanged.

• Replace

 — DCMlink imports the Tag and replace the existing Tag. The imported Tag's 
datasets replace the existing Tag's datasets.

• Merge

 — DCMlink imports the Tag datasets and includes them with the existing Tag's 
datasets.

• Change

 — DCMlink provides this option to the user to type a new Tag that does not 
match the name of an existing Tag in the database. DCMlink changes the 
Tag and imports the Tag and its associated datasets. The existing Tag and its 
datasets remains unchanged.

• Apply to all Tags

 — DCMlink selects same option for the remaining Tags while importing. 
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• Export Tag Data

Copies selected tags and selected datasets from the DCMlink database into a file. User can 
import this file into another DCMlink Software database or into other Windows applications.

 

NOTE: 

The Datasets to Include in Export File option is only available under DCMlink Solo.  
When running SNAP-ON, all datasets are always included in the export file.

 — From Tag menu click Export Tag Data.

 — Below Dialog Box will appear for Export options.

 — Select Tag to export and click Add.

 — While Exporting Tag user can select/deselect the Dataset to include in the 
Export file.

 — Click Export Tags.

Figure 329 Export Tag Data
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• File Name: 

 — For Single Tag: TagName_YYYYMMDD_HHMM  
(e.g.: 03631470_20160225_1755.dxp)

 — For Multiple Tags: MULTIPLE_TagS_YYYYMMDD_HHMM  
(e.g.: MULTIPLE_TagS_20160225_1755.dxp) 

18.5.11 Open Modify Tag

This option is available in Tag Menu and Database option. The Tag Management window opens 
when this command is selected. The Tag Management window enables user to search for and 
select a particular tag to open, modify, copy, or delete. Use tag groups to narrow search criteria. 

 — From Tag menu click Open Modify Tag.

Figure 330 Open Modify Tag From Tag Menu

 

 – Right click Database Open Modify Tag.

Figure 331 Open Modify Tag From Database option
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 — Tag Management Dialog box will appear to select  the Tag to Open, Modify, 
Delete, Copy, and Print List option.

Figure 332 Tag Management

 

• Tags: 

 — Allows search for Tag in list.

 — If user entered Tag is found, Tag will be shown and highlighted.

 — Tags Found list shows all the Tags available in application.

• Tag Groups:

 — It contains group name.

 — The drop down list contains the associated selections.

 — DCMlink lists Tags associated with the selected group and selection in the Tags 
Found box.

• Tags Found:

 — Tags Found lists the Tags that matches the search criteria entered in the Tag 
box and selected from the Tag groups.

• Information box:

 — It shows important data associated with the selected Tag as below.

 – Device Protocol: HART/FF.

 – HART Tag: HART Tag Number. For FF this should be Device Tag.

 – Group name: Group 1 to 4 names should be displayed.

 – Actuator Model: TEC2000, TEC2, M2CP, MPA, HQDCM33, and EHO.

 – Actuator Type: Quarter turn or Multi-turn.

 – Actuator S/N: Actuator serial number.

 – Descriptor: Description about the device. 
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After selecting a Tag in the Tags Found box, it further allows to open, modify, copy, or delete 
the Tag or print a Tag report. 

NOTE:

DCMlink allows to select only one Tag at a time from Tags Found list.

• Open Tag:

 — If click on this, DCMlink opens the selected Tag related to Status Monitor 
screen. 

 — Opens the selected tag so that you can configure, calibrate, or test an 
instrument.

• Modify Tag:

 — If click on this, DCMlink opens Modify Tag dialog. 

 — Opens a window where user can change information that identifies the 
selected tag and its associated database record in DCMlink software.

• Copy From Tag:

 — Opens the Copy Tag dialog box. Note that the selected tag is identified in the 
window title bar. Enter a new tag descriptor up to 25 characters. Click the OK 
button to copy information that identifies the selected tag and its associated 
database record in DCMlink software.

• Delete Tag:

 — It deletes the selected Tag from the Tags found list and all associated database 
records from DCMlink software.

 — At the confirmation message, user need to click Yes to delete the selected tag 
and its associated DCMlink Software database records. Click No to close the 
confirmation message window and return to the Tag Management window.

NOTE:

DCMlink does not allow deleting an Open Tag. 

• Print List:

 — Opens Print Tag Report window. In the Print Tag Report window, select 
information to print and design the format of the printed tag report for the 
selected tag.
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Section 19: Frequently Asked Questions

19.1 Usage

1. Where can I get the latest version of DCMlink? 
Please contact the nearest Emerson Local Business Partner for the latest version.

2. Will I be notified if a new version of DCMlink is released? 
No. However, users can call Technical Support regarding the latest version.

3. What do I do if my DCMlink installation doesn't detect the installed actuator(s)?

a. Cross check wire connection.

b. Check communication settings.

c. Refer to the above chapters for connection details.

d. If the steps in the User's Guide fail to solve the issue, please contact Emerson 
technical support.

4. Can I add actuator models to the device scan function to use unlisted models? 
No. User can request to add unlisted actuator models by calling Technical Support team.

19.2 RS485 Modem and Driver Details

DCMlink is tested using the USB to RS485 modem from B&B Electronics.

Figure 333 B&B Electronics USB to RS485 Modem
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19.2.1 Installation is accomplished by downloading and installing the latest driver. The version 
listed below (and newer) is fit for use.

 — USB-to-Serial-2.08.28 or later.  
(Verify through control panel; Device Manager)

Figure 334 Version Listing in Device Manager 

19.3 Wiring the Modem and Actuator

19.3.1 Details on wiring the actuator can be found in Section 7.

19.3.2 Details on wiring the modem are shown below:

Figure 335 Modem Wiring Legend (1)
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Figure 336 Modem Wiring Legend (2)

Figure 337 Modem Wiring Legend (3)

NOTE:  

Wiring connection details are found on the datasheet of the modem the user has purchased.
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19.4 Bluetooth Stack Information

19.4.1 Microsoft Stack 
This type of stack is the first of the two Bluetooth stacks supported in DCMlink. 
Microsoft stack is a Bluetooth stack developed by Microsoft for the Windows  
operating system. 

Figure 338 Microsoft Bluetooth Device in Device Manager

Figure 339 Microsoft Bluetooth Driver Details
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19.4.2 Broadcom Stack 
This is the second supported Bluetooth stack in DCMlink. Widcomm was the first 
Bluetooth stack for the Windows operating system. The stack was initially developed 
by a company named Widcomm Inc.

Figure 340 Broadcom Bluetooth Device in Device Manager  

Figure 341 Broadcom Driver Details
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19.5 Wiring the HART Modem and MUX 

19.5.1 Details on wiring the actuator can be found in Section 7.

19.5.2 Details on wiring the modem are shown below:

Figure 342 HART Modem Wiring 

Figure 343 MUX Wiring 
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19.6 Technical Support and Contact Details

Whom will I contact for installation and licensing issues? 
Please contact the nearest Emerson Local Business Partner. For further help, please contact the 
DCMlink Helpdesk using the contact information below: 

• Phone Number:  
International Access Code +1(281) 499-1561 / (800) 679-1561 toll-free (US Only)

• Fax Number:  
International Access Code +1(281) 499-8445

• E-Mail Address:  
DCMlink.Registration@Emerson.com

19.7 Trademarks

• DCMlink Software, Bettis™ and EIM™, Fisher®, AMS™ Intelligent Device Manager, 
SNAP-ON™, PlantWeb®, Ovation®, and DeltaV™  are the trademarks owned by one of 
the companies of Emerson Electric Co. 

• Emerson logo is a trade and service mark of Emerson Electric Co.

• FOUNDATION™ is a trademark of the Fieldbus Foundation.

• HART® is a registered trademark of the HART Communication Foundation.

• Bluetooth® is a registered trademark of Bluetooth SIG Inc.

• All other company and product names mentioned in this document are trademarks or 
registered trademarks of their respective companies. 

mailto:DCMlink.Registration%40emerson.com?subject=DCMlink%20Registration
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• 87360: DCMlink Software Basic

• 87361: DCMlink Software Advanced

• 87367: CD Media 

• 87368: DCMlink - USB Media
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Section 21: Troubleshooting

21.1 Device Scan Troubleshooting

COM port settings shall match with device(s)

• The Baud rate, parity and polarity shall match. 

• ALL devices connected to the same COM port shall use the same settings.

• Use multiple COM ports in case different settings are required.

• Monitor traffic with Live Communication Viewer.

• Available via each COM port listed on the Tree view.

• BAD PACKETS are indicative one or more of the issues listed.

• Physical connection:

 — Incorrect COM port

 — Incorrect communication settings

 — Polarity of physical connection

 — Actuator not powered

21.2 DCMlink Services Error

For DCMlink Service Error click on Restart DCMlink serices from DCMlink Setup Menu.

Figure 344 DCMlink Services Error

Figure 345  Restart DCMlink Services
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A.1 Definition of Terms

1. ACM  
Acronym: Auxiliary Control Module

2. Address 
One or more integers arranged to identify the location of an instrument or multiplexer.

3. AI/AO 
Acronym: Analog Input/Analog Output

4. AMS 
AMS Device Manager is plant asset management software from Asset Optimization 
(Emerson). It provides a single application for predictive diagnostics, documentation, 
calibration management, and device configuration for managing field instruments and 
digital valve controllers.

5. APD 
Acronym: Absolute Position Detector 
This module eliminates the need for any and all mechanical cam-driven switches. The 
assembly eliminates the need to open and close the control compartment to set travel 
and torque limits. It has no contacting components and is impervious to oil, greases 
and grime. 

6. ARM 
Acronym: Auxiliary Relay Module

7. ASCII 
Acronym:  American Standard Code for Information Interchange

8. Byte 
A unit of binary digits (bits). A byte consists of eight bits.

9. Baud Rate 
Data transmission speed. The baud rate is the rate at which information is transferred 
in a communication channel. In the serial port context, 9600 baud means that 
the serial port is capable of transferring a maximum of 9600 bits per second. If the 
information unit is one baud (one bit), the bit rate and baud rate are identical.

10. CAM 
Acronym: Communication Adapter Module

11. CCM 
Acronym: Central Control Module

12. COM Port 
COM (Communication port) is the original, yet still common, name of the serial port 
interface on IBM PC-compatible computers. It might refer not only to physical ports, 
but also to virtual ports, such as ports created by Bluetooth or USB-to-serial adapters.

13. Data Bits 
The number of data bits in each character can be 7 (for true ASCII) or 8 (for most kinds 
of data, as this size matches the size of a byte). 8 data bits are almost universally used 
in newer applications.
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14. Device ID 
A unique identifier embedded in the instrument at the factory. DCMlink software uses 
this identifier to ensure it is communicating with the correct instrument.

15. DCMlink 
Acronym: 
Diagnostics - Torque Profile, Archived Torque profile, Partial Stroke 
Configuration - Detailed Setup for easy access to every parameter  
Monitoring - Real-time status of the device with pass/fail indication

16. DI/DO 
Acronym: Digital Input/Digital Output

17. Discrete 
Individually separate and distinct. Actuators take input and provide output in discrete 
format. The actuator can be controlled by discrete inputs: two-wire control, three-wire 
control and four-wire valve control. Discrete outputs are used primarily for hardwired 
status feedback. Each Discrete outputs (Relay) may be configured (assigned) to various 
status, alarm, or control functions.

18. Download 
Sending configuration instructions and calibration information from the DCMlink 
software database to a device.

19. ESD 
Acronym: Emergency Shut Down

20. EHO 
Acronym: Electro-Hydraulic Operator

21. HART 
Acronym: Highway Addressable Remote Transducer 
The HART Communications Protocol (Highway Addressable Remote Transducer 
Protocol) is an early implementation of Fieldbus, a digital industrial automation 
protocol. Its most notable advantage is that it can communicate over legacy 4-20 mA 
analog instrumentation wiring, sharing the pair of wires used by the older system. 

22. HZ (Hertz) 
The frequency of the applied motor voltage and control package voltage.

23. IOM 
Acronym A: Instruction and Operation Manual 
Acronym B: Input/Output Module

24. Inhibit 
Actuators can be prevented from operating in either OPEN or CLOSE direction, or 
both, until an external contact has been made. This is useful when interlocking with 
other process equipment (e.g. pumps, other valves, sensors, PLC, DCS, etc.), and it will 
inhibit operation in both remote and local operating modes. 

25. LDM 
Acronym: Local Display Module

26. LSA 
Acronym: Limit Switch A 
It’s the Intermediate limit A.

27. LSB 
Acronym: Limit Switch B 
It’s the Intermediate limit B.
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28. LSC 
Acronym: Limit Switch Close 
It’s the Close limit.

29. LSO 
Acronym: Limit Switch Open 
It’s the Open limit.

30. mA 
Milliampere(s): Unit of measurement for small electric currents. 

31. MCP 
Acronym: Modular Controls Package – first generation 

32. MCM  
Acronym: Motor Control Module

33. MPA 
Acronym: Multiport Actuator 

34. MPFS 
Acronym: Multiport Flow Selector

35. Modbus 
Modbus  is a serial communications protocol originally published by Modicon (now 
Schneider Electric) in 1979 for use with its programmable logic controllers (PLCs). 
Simple and robust, it has since become a de facto standard communication protocol, 
and it is now a commonly available means of connecting industrial electronic devices.

36. MUX  
Acronym: Multiplexer

36. Navigation Pane 
Sidebar view in DCMlink that shows the communication protocols and installed Tags.

37. Parity 
Parity is a method of detecting errors in transmission. When parity is used with a serial 
port, an extra data bit is sent with each data character, arranged so that the number of 
1 bits in each character, including the parity bit, is always odd or always even. 

38. Phase  
This is the electric service used with the actuator’s motor.

39. Polling Range 
Range of actuator addresses in Modbus.

40. PST

         Partial Stroke Test

40. FST

         Full Stroke Test

40. QSG 
Acronym: Quick Start Guide

41. RDM 
Acronym: Remote Display Module

42. RPM  
Constant speed of the actuator motor on this individual actuator. Can be 1725 or 3400 
RPM motor.
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43. RPM/Seconds 
This is the time in seconds that it takes an actuator to operate a multi-turn or quarter 
turn valve. For example, a 30-second rating is the time it takes the actuator to move 
the attached valve from open to close or close to open.

44. Run Amps  
This is the amperage that the motor should draw at full load without the thermal 
overloads tripping. This also indicates that the motor is a limit duty unit that must be 
allowed to cool off after 15 minutes of continuous operation. There are no vents or 
airways used to cool the motor during operation except through ambient conditions 
outside of the housing.

45. STC 
The TEC2000 STC (Separate Terminal Chamber) is an isolated point that is separate 
from the controls enclosure.

46. Stall amps  
This is the locked rotor amperage of a motor when it is mechanically prevented from 
rotating the actuator’s power gear train. Generally, this is at least three times the 
running amperage of the motor and the point at which the thermals will trip the  
motor offline.

47. Stop Bits 
Stop bits sent at the end of every character allow the receiving signal hardware 
to detect the end of a character and to re-synchronize with the character stream. 
Electronic devices usually use one stop bit.

48. Tag 
A unique identifying mnemonic or label for a controller or point of a process control 
system. Typically, this is a valve Tag number or location for assembly placement in a 
plant's operation.

49. TBM 
Acronym: Terminal Board Module

50. TCP/IP 
TCP/IP (Transmission Control Protocol/Internet Protocol) is the basic communication 
language or protocol of the Internet. It can also be used as a communications protocol 
in a private network (either an intranet or an extranet).

51. Tmot 
Abbreviation: Timeout
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